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Introduction 

Thank you very much for your purchase of this Toshiba pocket personal computer.  
Please be sure to read this user’s guide before using the Toshiba Pocket PC, and 
ensure that you are aware of correct handling procedures. 
■ Please be sure to read “Safety precautions” in this document since these 

describe important safety issues. 
■ After reading this document, keep it in a convenient place for future reference. 

Copyright 
© 2001 by Toshiba Corporation. All rights reserved. Under the copyright laws, this 
manual cannot be reproduced in any form without the prior written permission of 
Toshiba. No patent liability is assumed, with respect to the use of the information 
contained herein. 
Toshiba Pocket PC e570 User’s Guide 
First edition September 2001 

Trademarks 
Microsoft, ActiveSync, Outlook, Pocket Outlook, Windows, Windows NT, and the 
Windows logo are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries. Microsoft products are 
licensed to OEMs by Microsoft Licensing, Inc., a wholly owned subsidiary of Microsoft 
Corporation. 

Safety precautions 
■ Please read “Safety precautions” outlined here carefully before using the Toshiba 

Pocket PC and ensure that you are aware of correct handling procedures. 
■ The precautions stated here provide essential information for the protection of the 

user and others from possible injury and property damage, and on the safe 
handling of the product you have purchased. 

■ Please check that you fully understand the definition of the following messages 
(signs and graphical symbols) before going on to read the text, and always follow 
the instructions. 
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Explanation of signs 
Signal words such as WARNING, CAUTION, and NOTE, will be followed by important 
safety information that must be carefully reviewed. 

Icon Meaning 

 
Indicates a potentially hazardous situation, 
which could result in death or serious injury 
(*1) if you do not follow instructions. 

 
Indicates a potentially hazardous situation, 
which if not avoided, can result in minor 
injury (*2) or property damage (*3). 

 
Gives you helpful information. 

*1: Serious injury corresponds to an injury that leaves some after effect, and requires hospital treatment or 
long term treatment as an outpatient such as blindness, injuries, burns (high temperature, low temperature), 
electric shock, fractures, poisoning, etc. 
*2: Minor injury corresponds to an injury that does not require hospital treatment or long term treatment as 
an outpatient, that is to say, injuries, burns, electric shock, etc. 
*3: Property damage corresponds to the extensive damage with regard to the house structure, household 
goods, livestock, pets, etc. 

Limitation of liability 
■ Toshiba Corporation is in no way liable for any damage resulting from 

earthquakes, fire, actions on the part of a third party, other accidents beyond the 
control of Toshiba Corporation or intentional acts, negligence or misuse on the 
part of the user or any usage under abnormal conditions. 

■ Toshiba Corporation is in no way liable for any damage, including but not limited 
to change or loss of stored data, loss of business profit, lost profits, interruption of 
business, or lost communication opportunities that are caused by usage or non-
usability of this product. 

■ Toshiba Corporation is in no way liable for any damage resulting from failure to 
comply with the contents of this user’s guide. 

■ Toshiba Corporation is in no way liable for any damage resulting from malfunction 
due to usage in combination with connection devices, software, or devices other 
than those provided by Toshiba Corporation with the product.  
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Handling the unit (including the built-in batteries) 

WARNINGS 
■ Turn the Toshiba Pocket PC power off in areas where usage is prohibited, such 

as onboard an aircraft or in a hospital.  
 Usage in such areas can cause an accident due to negative effects on equipment 

such as aviation equipment or medical equipment. 
■ Keep the Toshiba Pocket PC no less than 9 inches away from persons with a 

heart pacemaker implant when using the device in combination with a mobile 
phone. 

 Failure to maintain this distance can cause an accident due to negative effects on 
the pacemaker at close proximity. 

■ Do not use the Toshiba Pocket PC when driving a car or while walking. 
 Usage when driving a car or while walking can cause a traffic accident or injury. 
■ Do not allow metallic objects, such as staples and clips, to enter inside the 

Toshiba Pocket PC.  
■ Do not connect the terminals (metallic parts) with metallic objects. 
 Entry of, or contact with, foreign objects can cause heat generation. 
■ If the Toshiba Pocket PC emits an unusual smell or sound, or generates smoke, 

turn the battery switch to the off position immediately and disconnect the AC 
adapter from the power outlet. 

 Please contact the dealer from whom the Toshiba Pocket PC was purchased and 
request inspection or repair service. 

■ Do not use or store in the following locations. 
■ Locations such as a bathroom where the Toshiba Pocket PC can be 

subjected to water splashes or conditions of high humidity. 
■ Locations where rain, fog, etc. can enter directly. 
■ Locations subject to high temperatures, such as near to a fire or heating 

equipment. 
■ Locations exposed to direct sunlight. 
■ Inside a tightly closed car under hot sunlight. 
 The built-in battery can suffer liquid leakage, ignition, or rupture. 

■ Do not drop the Toshiba Pocket PC or allow the Toshiba Pocket PC to be 
subjected to any severe shock. 

 The built-in battery can suffer liquid leakage, ignition, or rupture. 
■ If the built-in battery leaks liquid, or emits an unusual smell, remove it immediately 

from the vicinity of any source of fire. 
 Continued use of the Toshiba Pocket PC under any of these conditions can cause 

ignition of the leaked liquid, or rupture.  
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■ If liquid leaks from the built-in battery, do not touch it. 
 If such liquid is allowed to come into contact with the skin, it can cause eye or 

skin injuries. If the liquid should enter the eyes, irrigate the eyes thoroughly with 
clean water and immediately seek medical attention. If the liquid should come into 
contact with the skin or clothing, wash it away immediately with clean water. 

■ Do not disassemble, remodel or repair. 
 Disassembly, remodeling, or repair can cause injury. 
 Please contact the dealer from whom the Toshiba Pocket PC was purchased and 

request repair service. 

CAUTIONS 
■ When using the Toshiba Pocket PC with the earphone (sold separately) 

connected to it, do not raise the sound volume level too high. 
 Raising the sound to high volume levels can impair your hearing ability. 
■ If the display is broken, and the liquid crystal (liquid) leaks out, do not touch it. 
 In the event of contact with the skin, the liquid crystal can cause a rash on the 

skin. If the liquid crystal should come into contact with the skin or clothing, wash it 
off immediately with clean water. 

■ Keep the Toshiba Pocket PC out of the reach of infants. 
 Placing within the reach of infants can cause injury. 

Handling AC adapter, power cord, cradle 

WARNINGS 
■ Use only the AC adapter supplied with the Toshiba Pocket PC. 
 Using an AC adapter other than that supplied can cause smoke or ignition. 
■ Insert the power plug to a household electric outlet supplying 115V AC. 
 Inserting the power plug into an outlet of any other supply voltage can cause fire. 
■ Do not connect or disconnect the power plug with wet hands. 
 Connecting or disconnecting under these conditions can cause electric shock. 
■ Do not leave open containers filled with liquid, such as cups, near the AC adapter.  
 Spilt liquid entering the Toshiba Pocket PC can cause ignition or electric shock. 
■ Do not use the Toshiba Pocket PC in locations, such as a bathroom, where it will 

be subjected to liquid splashes.  
 Exposure to liquid can cause ignition or electric shock. 
■ If dust is found on or around the pins of the power plug, turn off the Toshiba 

Pocket PC and disconnect the power plug from the outlet, then wipe off the dust 
using a dry cloth. 

 Dust accumulation on the power plug can cause fire due to loss of insulation. 
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■ Do not disassemble, remodel, or repair. 
 Disassembly, remodeling, or repair can cause fire, electric shock, or injury. 
 Please contact the dealer from whom the Toshiba Pocket PC was purchased and 

request repair service. 

CAUTIONS 
■ When unplugging the power plug from the outlet, disconnect the power cord by 

grasping the power plug itself. 
 Pulling out the power cord by grasping the cable can cause ignition or electric 

shock due to cable damage. 
■ When handling the power cord, observe the following rules. 

■ Do not damage the power cord. 
■ Do not tamper with the power cord. 
■ Do not twist the power cord. 
■ Do not forcibly bend the power cord. 
■ Do not pull the power cord. 
■ Do not overload the power cord. 
■ Do not heat the power cord. 
■ Do not place it close to heating apparatus. 

 Failure to do so can cause fire or electric shock. 
 If you find that the power cord is damaged, please call the dealer from whom the 

Toshiba Pocket PC was purchased and purchase a new power cord. 
■ Do not connect terminals (metallic parts) with metallic objects, such as wires. 
 Connecting the terminals (metallic parts) with metallic objects can cause heat 

generation or burns. 
■ Keep the Toshiba Pocket PC out of the reach of infants. 
 Placing within the reach of infants can cause injury. 

NOTES 
■ Use the Toshiba Pocket PC only in locations with the following ambient 

environmental conditions. 
■ When operating Temperature 32°F to 104°F, Humidity 30% to 80 
■ When charging Temperature 41°F to 95°F 

■ Do not use or store the Toshiba Pocket PC in the following locations. 
■ Locations subject to extremely high or low temperatures 
■ Dusty locations 
■ Locations subject to strong vibration 

 Usage or storage in such locations can cause failure, malfunction, or loss of 
stored data.  
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■ Do not allow the Toshiba Pocket PC to be subjected to sharp temperature 
changes. 

 The resulting moisture condensation can cause failure, malfunction, or loss of 
stored data. 

 If moisture condensation is generated, use the Toshiba Pocket PC only after 
allowing it to dry completely. 

■ When charging the battery, the case of the AC adapter can become warm, but 
this is not abnormal. 

■ Disconnect the power plug from the outlet when not in use. 
■ Avoid inadvertently sitting while the Toshiba Pocket PC is inserted in the back 

pocket of trousers, etc. 
 Sitting under these circumstances can cause damage or failure. 
■ Do not place objects or drop them on top of the Toshiba Pocket PC. 
 When the Toshiba Pocket PC is placed in a bag containing heavy items, do not 

allow it to be caught underneath them. 
 Placing it under these conditions can cause damage or failure. 
■ Clean the terminals (metallic parts) occasionally with a Q-tip.  
 Dirty terminals can cause disconnection or poor charging. 
■ Do not use organic solvents such as benzene or thinner to clean the Toshiba 

Pocket PC. 
 Use of these solvents can cause deformation or discoloration. 
 Wipe dirty parts with a soft dry cloth. 
■ Do not wipe the display with a wet cloth. Do not touch it with wet hands. 
 Wiping or touching under these conditions can cause failure or malfunction. 
 Wipe the display with a soft dry cloth. 
■ It is recommended that important data stored in the unit should be backed up 

occasionally via a memory card (sold separately) or personal computer (data 
transfer with Active Sync).  

 The following can result in loss of stored data. 
■ Misuse of the Toshiba Pocket PC 
■ Subjecting the main unit to the effects of static electricity or electric noise 
■ Total loss of charge in the built-in battery due to an extended period of non-

use 
■ Failure or repair servicing of the Toshiba Pocket PC 

■ Toshiba Corporation is in no way liable for change or loss of stored data resulting 
from failure or repair of the unit. Please understand this before usage.  

■ When using the optional “SD memory card”, “CompactFlash card”, please be 
sure to read the relevant user’s guide and ensure that you are aware of correct 
handling procedures. 
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■ Do not allow the card to be subjected to any severe shock while connected to 
the unit. Such shocks can cause damage or failure. 

■ Do not carry the unit with the card still connected.  
 Carrying the unit with the card connected can cause loss of the card due to it 

falling from the unit.  
■ A lithium ion battery is used as the built-in battery. 
 Please request the dealer from whom the Toshiba Pocket PC was purchased to 

replace the built-in battery when this becomes necessary. Lithium ion batteries 
are recyclable.  When you replace your built-in battery, please request that the 
repair center recycle the battery.  Never dispose of the battery with ordinary 
waste. 

The lithium ion battery can explode if not properly replaced, used, handled or 
disposed of. Dispose of the battery as required by local ordinances or regulations. 
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Chapter 1 

Getting Started 

Welcome 
Congratulations on purchasing a Toshiba Pocket PC. Due to the size and capabilities 
of this Toshiba Pocket PC, you can keep your most important business and personal 
information up-to-date and close at hand. Microsoft® ActiveSync® increases the power 
of your Toshiba Pocket PC by allowing you to synchronize the information on your 
desktop or laptop computer with your Toshiba Pocket PC. Picture yourself in the 
following situations: 
■ While walking with a colleague, your cellular phone rings and your manager asks 

if you two are free this afternoon for an emergency meeting. While your colleague 
fumbles through his paper organizer, you press a button on your Toshiba Pocket 
PC and instantly see a list of today’s appointments and meetings. You are quickly 
able to tell your manager your available times. For more information on 
scheduling appointments and meetings, see Chapter 4. 

■ You’re meeting your friends tonight for dinner and a movie. You download the 
latest movie information from the Internet to your computer and then synchronize 
it with your Toshiba Pocket PC. At dinner, you pull out your Toshiba Pocket PC 
and review your movie options with your friends. For more information on 
downloading Web pages to your Toshiba Pocket PC, see Chapter 6. 

■ A Calendar reminder alerts you that it is time to catch the bus. You grab your 
Toshiba Pocket PC and catch the bus just in time. Because ActiveSync keeps the 
information on your Toshiba Pocket PC up-to-date, you leisurely review your task 
list, make notes about the new books and CDs you want to buy, and read and 
respond to e-mail messages. When you get back to the office, ActiveSync 
transfers any task changes you made, your notes, and your e-mail message 
responses to your computer. For more information on ActiveSync, see Chapter 3. 
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Where to Find Information 
This book describes your Toshiba Pocket PC hardware, provides an overview of the 
programs on your Toshiba Pocket PC, and explains how to connect your Toshiba 
Pocket PC to a computer, a network, or the Internet. For instructions on setting up 
your Toshiba Pocket PC and installing ActiveSync, see the Quick Start card. The 
following table is a guide to additional information to help you use your Toshiba Pocket 
PC. 

For information on: See this source: 

Programs on your Toshiba 
Pocket PC 

This User’s Guide and device Help. To view Help, tap 
 and then Help. 

Additional programs that can 
be installed on the Toshiba 
Pocket PC 

The Toshiba Pocket PC Companion CD. 

Connecting to and 
synchronizing with a 
computer  

The Quick Start card or ActiveSync Help on your 
computer. To view Help, click Help and then Microsoft 
ActiveSync Help. 

Last-minute updates and 
detailed technical information 

The Read Me files, located in the Microsoft ActiveSync 
folder on the computer and on the Toshiba Pocket PC 
Companion CD. 

Up-to-date information on 
your Toshiba Pocket PC 

http://www.microsoft.com/mobile/pocketpc 
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Chapter 2 

Basic Skills 

You can easily learn to use your Toshiba Pocket PC. This chapter describes the use 
and customization of your Toshiba Pocket PC. 

Parts Names and Function 

Main unit (front view) 
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Battery/ Alarm Lamp LED 

Recording Button 
(Program Button 5) 

Program Button 1, 2, 3, & 4 
(from the left) 

Reset Switch 

 Cursor Button/ 
Navigation  
Button 

Speaker 

Touch Screen 

Power Button/ 
Front Light 

Infrared Port 

Microphone 

Cradle Con- 
necting Port 

AC Adapter  
Jack 

Battery Switch 

Battery Switch Lock 
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The USB Cradle 

 

Initial Setting of Program Button 
Program button 1 = Calendar 
Program button 2 = Tasks 
Program button 3 = Home 
Program button 4 = Contacts 
Program button 5 = Voice recorder  
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Main unit (back view)  

 

Power Button 
The power button turns the unit and the front light on and off. 

Power button When the power is off When the power is on 

Press it for some time. The power turns on. The front light alternately 
turns on/off. 

Press it quickly. The power turns on. The power turns off. 

Stereo  
Headphone jack 

SD Card Slot 

CF Card Slot 

Stylus 

Stylus Holder 
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Battery Switch and Battery Switch Lock 
The battery switch supplies/cuts off the battery power to the Toshiba Pocket PC. 
The setting of this switch at shipment is “stop”. When using the Toshiba Pocket PC for 
the first time, slide this switch to the right (the “supply” side) with the stylus. This 
switch should be on the “supply” side. 
The battery switch lock secures the battery switch to the “supply” side. 
Set the battery switch from the “supply” side to the “stop” side while sliding the battery 
switch lock to the “release” side with the stylus. 

 

Alarm Lamp LED 
The alarm lamp indicates the machine condition. 

Flashing orange When the preset alarm time, which was set through 
Calendar or Tasks, goes off, the lamp starts flashing. 

Steady orange Indicates charging of the built-in battery.  

Flashing yellow The built-in battery charging process is stopped due to
the ambient temperature being too high or low. 
Charge the built-in battery in an ambient temperature 
of approx. 41°F to 95°F. 

Steady green Indicates full charge of the built-in battery. 

Supply 

Stop 

Battery  
Switch 

Release 

Battery Switch Lock 
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How to Use the Stylus 
The stylus is used for menu selection or data input on the touch-screen of the Toshiba 
Pocket PC. 
■ Tap:  Touch the screen once with the stylus to open items and select options. 
■ Drag:  Hold the stylus on the screen and drag it across to select text and images. 

Drag in a list to select multiple items. 
■ Tap and hold:  Tap and hold the stylus on an item to see a list of actions 

available for that item. On the pop-up menu that appears, tap the action you want 
to perform. 

When you operate the touch screen of the Toshiba Pocket PC, use the supplied 
stylus. 
If the tip of the stylus is damaged, do not use it. If you operate the touch screen with a 
damaged stylus or a ballpoint pen, the touch screen may be damaged. 
When the stylus is damaged, please purchase a new one. 

About the Cursor Button 
You can move a cursor (selection display) on the screen by pressing the upper, lower, 
right or left part of the cursor button. 
You can select a program to launch by pressing the center part of the cursor button. 

The cursor movement is different depending on the screen. When the cursor is at the 
right or the left side of the screen, it may not move. 
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Battery Charging 
A built-in battery is installed in the Toshiba Pocket PC. When using the Toshiba 
Pocket PC for the first time, set the battery switch to the supply side, and then charge 
the built-in battery with the supplied AC adapter. 

How to Charge the Battery 
You can use two charging methods. 
When you connect the AC adapter and the Toshiba Pocket PC, turn the unit off. 
1. Connect the supplied AC adapter and the cradle as shown in the figure below, 

and then insert the Toshiba Pocket PC into the cradle. 

 

2. Connect the supplied AC adapter and the Toshiba Pocket PC as shown in the 
figure below. 
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For charging the built-in battery, maintain an ambient temperature from approx. 41°F 
to 95°F. 
When the lamp is lit in orange during the built-in battery charging, you can use the 
Toshiba Pocket PC.  
When the built-in battery is completely charged, the LED alarm lamp color will change 
to green. 

How to Prolong Battery Life 
■ Use the Toshiba Pocket PC with the AC adapter. 
 When you use the Toshiba Pocket PC under the following conditions, the power 

consumption will be large. Please use the AC adapter when: 
■ The Toshiba Pocket PC is operated while connected to your computer. 
■ The Toshiba Pocket PC is operated with storage card or with any other 

optional equipment. 
■ Select the short power-off time in the setting menu. This will shorten the time the 

unit will remain on if not used. For more information, see “Customize Your 
Toshiba Pocket PC” in Chapter 2. 

■ Turn off the front light. 
■ Set the screen brightness to power saving mode. Also shorten the light turn-off 

time. For more information, see “Customize Your Toshiba Pocket PC” in Chapter 
2. 

■ Use the Toshiba Pocket PC with an ambient temperature between 59°F and 
77°F. This temperature range is the most effective for the built-in battery. 
■ When you use the Toshiba Pocket PC in high or low temperature 

environments, the operable time is shortened due to the decrease of the 
built-in battery capacity. 

Battery Life 
The built-in battery has a limited life. Repeated charging/discharging of the built-in 
battery gradually decreases operable time. When the operable time has been 
extremely shortened, it is time to replace the built-in battery with a new one.  
■ Do not leave the Toshiba Pocket PC in a place of high or low temperature. It may 

shorten battery life. 
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Battery Charge Level and Stored Data Protection 
If the battery charge level becomes extremely low, or is completely discharged, the 
memory data stored in the Toshiba Pocket PC will be deleted. 
When the low battery status icon or the alarm message appears, immediately connect 
the AC adapter to the Toshiba Pocket PC and charge the built-in battery. 
■ The built-in battery gradually discharges even if the device is not being used. 

When the Toshiba Pocket PC is left for a long time, the built-in battery of the 
Toshiba Pocket PC may completely discharge. 

■ It is recommended to save the Toshiba Pocket PC’s memory data to your 
computer or to a storage card.  

■ The manufacturer is not responsible for data change or clearance due to battery 
discharge. Please acknowledge that. 

Initial Setup 
When using the Toshiba Pocket PC for the first time, carry out initial setup according 
to the procedures below after a built-in battery has been charged. 
1. Press the power button to turn the power on. The Welcome screen appears. Tap 

the screen to start the following setup. 
2. Execute touch screen correction. 
 When the align screen appears, tap the center of the cross target with the stylus. 

The next target position changes upon tapping the target. Five taps completes 
the positioning correction. The screen then changes to the Stylus screen. 
■ If a finger or any other object touches the screen during correction, the 

correction will be cancelled. Repeat the correction procedure. 
3. Read how to use the stylus. 

■ Read and understand the stylus operation, and then tap NEXT. 

For more information on stylus operation, see “How to Use the Stylus” in Chapter 2. 

4. Learn the pop-up menu operation. 
■ Read the on-screen explanation and then follow the instructions. 
 Display the pop-up menu, and cut and paste the data according to the screen 

instructions. 
■ After you finish the paste operation, this stage is completed. Tap NEXT. 

5. Set the ZONE. 
■ When tapping the right ▼ mark, the city and the time zone lists appear. Tap 

the desired city and time zone.  
■ When the setup is completed, tap NEXT. 
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6. To complete the initial setup. 
■ When the Complete screen appears, the initial setup is completed. 
■ After tapping the screen, you can use the Toshiba Pocket PC. 

When you tap the Complete screen, the Today screen appears. For more information 
on the Today screen, see “Today screen” in Chapter 2. 

Setup Method of Options 

Method of Setting Card into CF Card Slot 
To insert a card: 
1. Turn off the power. 
2. Open the card cover. 
3. Insert the CF card confirming the direction of the card. Line up the side grooves 

of the card and the groove edge of the card slot. 
 Insert the card smoothly and completely. 

■ When the card is inserted, the power turns on. 
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To remove a card: 
1. Turn off the power. 
2. Open the card cover. 
3. Hold the protruding edge of the card, and then pull the card straight out. 

■ When the card is removed, the power turns on. 

 

Method of Setting Card into SD Card Slot 
To insert a card: 
1. Turn off the power. 
2. Open the card cover. 
3. Insert the card with its contact surface (metal contact surface) facing the back of 

the Toshiba Pocket PC. 
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To remove a card: 
1. Turn off the power. 
2. Open the card cover. 
3. Lightly press down the card until a clicking sound is heard. The card will pop out 

slightly from the slot. 
4. Pull the card straight up to remove. 

 

When storage cards are inserted in both the CF and SD card slots, one of them may 
only be accessible depending on the application or the Settings operation (typically, 
the first storage card inserted is accessed). 
Typical examples: 
-  Notes of Pocket Outlook 
-  Saving the destination selection of the Options item of the Tools menu of Pocket 
Word 
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To connect Remote Control-Fitted Earphone Microphone 
You can listen to the sound output from your Toshiba Pocket PC by connecting the 
optional remote control-fitted earphone microphone. 
Insert the optional remote control-fitted earphone plug into the stereo headphone jack 
as shown in the figure below. 

 

Use the specified remote control-fitted earphone. If you use a different type of 
earphone, it may malfunction. 
The connectable pin size of the headphone/earphone is a 3.5 mm mini plug type. 

Connecting to a Computer 
Before connecting your Toshiba Pocket PC to a computer, check the following. 
■ ActiveSync has been installed on your desktop. (See Chapter 3.) 
■ The Toshiba Pocket PC and the computer are both turned off. 
■ The position of connecting port on the computer may differ according to the 

computer type.  
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To Connect Using The Supplied USB Cradle: 
1. Connect the USB cradle to your computer as shown in the illustration below. 

 

2. Insert the Toshiba Pocket PC into the USB cradle. 

 

■ Make sure that the connector on the cradle is inserted into the port on the 
bottom of the Toshiba Pocket PC. Data cannot be transferred if the 
connection is not made. 

■ When your Toshiba Pocket PC is properly inserted into the cradle, your 
Toshiba Pocket PC will turn on and ActiveSync will open. 
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To connect using an optional serial cradle: 
1. Connect the serial cradle to the serial port of the computer. 

 

2. Connect the Toshiba Pocket PC to the serial cradle.  

To connect directly using an optional connection cable: 
Connect the Toshiba Pocket PC directly to your computer using an optional   USB 
cable. 
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Connect the Toshiba Pocket PC directly to your computer using the optional   serial 
cable. 
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Today Screen 
When you turn on your Toshiba Pocket PC for the first time each day (or after 4 hours 
of inactivity), you’ll see the Today screen. You can also display it by tapping  and 
then Today. On the Today screen, you can see important information for the day. 

 

Following are some of the status icons you may see. 

Status Icon Meaning 

 
Turns all sounds on and off and changes the volume 
level 

 
Batteries are charging  

 
Batteries are low  

 
Batteries are very low  

 
Batteries are full 

 
Connection is active  

Tap to view notification messages. 

Tap to change the volume level or to turn the volume on/off. 

Tap to change date and time. 

Tap to open the owner information  
window. 

Tap to switch to a 
program. 

Your day at a glance. 

Tap to view connection status. 

Tap to create a new item. 
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Status Icon Meaning 

 
Synchronization is beginning or ending 

 
Synchronization is occurring 

 
Notification that one or more instant messages were 
received 

 
Notification that one or more e-mail messages were 
received 

If more notification icons need to be displayed than there is room to display them, the 
Notification icon, , will display. Tap the icon to view all notification icons. 

Programs 
You can switch from one program to another by selecting it from the  menu. (You 
can customize which programs you see on this menu. For information, see “Adjusting 
Settings,” later in this chapter.) To access programs not listed on the drop down menu, 
tap , Programs, then the program name.  
You can also switch to certain programs by pressing a program button. Your Toshiba 
Pocket PC has 5 program buttons located on the front or the side of the Toshiba 
Pocket PC. The icons on the buttons on the front of the unit identify the programs they 
activate. Factory set programs are (from left to right) Calendar, Tasks, Home and 
Contacts. The program button on the side is Notes for voice recording. 

Some programs have abbreviated labels for check boxes and drop-down menus. To 
see the full spelling of an abbreviated label, tap and hold the stylus on the label. Drag 
the stylus off the label so that the command is not carried out.  
The 5 program buttons on your Toshiba Pocket PC are programmable to activate 
other programs than the preset programs. 
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The following table contains a partial list of programs that are on your Toshiba Pocket 
PC. Look on the Toshiba Pocket PC Companion CD for additional programs that you 
can install onto your Toshiba Pocket PC. 

Icon Program Description 

 
ActiveSync Synchronize information between your Toshiba Pocket

PC and computer. 

 
Calendar Keep track of your appointments and create meeting 

requests. 

 
Contacts Keep track of your personal and professional 

contacts. 

 
Inbox Send and receive e-mail messages. 

 
Pocket Internet Explorer Browse Web and WAP sites, and download new 

programs and files from the Internet. 

 
Notes Create handwritten or typed notes, drawings, and 

recordings. 

 
Tasks Keep track of your tasks. 

 
Pocket Excel Create Excel spreadsheet or view and edit Excel 

spreadsheet created on your computer. 

 
MSN Messenger Send and receive instant messages with your MSN 

Messenger contacts. 

 
Pocket Word Create new documents or view and edit Word 

documents created on your computer. 
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Navigation Bar and Command Bar 
The navigation bar is located at the top of the screen. It displays the active program 
and current time, and allows you to switch to programs and close screens. 
Use the command bar at the bottom of the screen to perform tasks in the open 
program. The command bar includes menu names, buttons, and the Input Panel 
button. To create a new item in the current program, tap New. To see the name of a 
button, tap and hold the stylus on the button. Drag the stylus off the button so that the 
command is not carried out. 

 

 

Tap to change volume or mute the Toshiba Pocket PC. 

Tap to quickly select a program you have recently used. 

Menu names. 
Buttons. 

Input panel button. New button. 

Tap to select a program. 

Tap to see additional programs. 

Tap to customize the Toshiba Pocket PC. 
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Pop-up Menus 
With pop-up menus, you can quickly choose an action for an item. For example, you 
can use the pop-up menu in the contact list to quickly delete a contact, make a copy 
of a contact, or send an e-mail message to a contact. The actions in the pop-up 
menus vary from program to program. To access a pop-up menu, tap and hold the 
stylus on the item name that you want to perform the action on. A red circle will 
appear, and then the pop-up menu will appear. When the menu appears, lift the 
stylus, and tap the action you want to perform. Or tap anywhere outside the menu to 
close the menu without performing an action. 

 

Notifications 
Your Toshiba Pocket PC reminds you in a variety of ways when you have something 
to do. For example, if you’ve set up an appointment in Calendar, a task with a due 
date in Tasks, or an alarm in Clock, you’ll be notified in any of the following ways: 
■ A message box appears on the screen. 
■ A sound, which you can specify, is played. 
■ A light flashes on your Toshiba Pocket PC.  
To choose reminder types and sounds for your Toshiba Pocket PC, tap  and then 
Settings. In the Personal tab, tap Sounds & Notifications. The options you choose 
here apply throughout the Toshiba Pocket PC. 

Tap outside the menu to close it without 
 performing an action. 

Lift the stylus and tap the action  
you want. 

Tap and hold to display the pop-up  
menu. 
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Enter Information on Your Toshiba Pocket PC 
You have several options for entering new information: 
■ Use the input panel to enter typed text by using the soft keyboard or other input 

method. 
■ Write directly on the screen. 
■ Draw pictures on the screen. 
■ Speak into your Toshiba Pocket PC microphone to record a message.  
■ Use Microsoft® ActiveSync® to synchronize or copy information from your 

computer to your Toshiba Pocket PC. For more information on ActiveSync, see 
ActiveSync Help on your computer. 

Entering Text Using the Input Panel  
Use the input panel to enter information in any program on your Toshiba Pocket PC. 
You can either type using the soft keyboard or write using Letter Recognizer, Block 
Recognizer, or Transcriber. In either case, the characters appear as typed text on the 
screen.  
To show or hide the input panel, tap the Input Panel button. Tap the arrow next to the 
Input Panel button to see your choices. 

 Input panel button. 

Tap to see your choices. 

Select an input method. 
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When you use the input panel, your Toshiba Pocket PC anticipates the word you are 
typing or writing and displays it above the input panel. When you tap the displayed 
word, it is inserted into your text at the insertion point. The more you use your Toshiba 
Pocket PC, the more words it learns to anticipate. 

 

To change word suggestion options, such as the number of words suggested at one 
time, tap , Settings, Personal tab, Input, and then the Word Completion tab. 

To type with the soft keyboard: 
1. Tap the arrow next to the Input Panel button and then Keyboard. 
2. On the soft keyboard that is displayed, tap the keys with your stylus. 

To use Letter Recognizer: 
With Letter Recognizer you can write letters using the stylus just as you would on 
paper. 
1. Tap the arrow next to the Input Panel button and then Letter Recognizer. 
2. Write a letter in the box. 
When you write a letter, it is converted to typed text that appears on the screen. For 
specific instructions on using Letter Recognizer, with Letter Recognizer open, tap the 
question mark next to the writing area. 

  

Tap here if this is the right word. 
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To use Block Recognizer: 
With Block Recognizer you can input character strokes using the stylus that are 
similar to those used on other devices. 
1. Tap the arrow next to the Input Panel button and then Block Recognizer. 
2. Write a letter in the box. 
When you write a letter, it is converted to typed text that appears on the screen. For 
specific instructions on using Block Recognizer, with Block Recognizer open, tap the 
question mark next to the writing area. 

To use Transcriber: 
With Transcriber you can write anywhere on the screen using the stylus just as you 
would on paper. Unlike Letter Recognizer and Block Recognizer, you can write a 
sentence or more of information. Then, pause and let Transcriber change the written 
characters to typed characters. 
1. Tap the arrow next to the Input Panel button and then Transcriber. 
2. Write anywhere on the screen. 
For specific instructions on using Transcriber, with Transcriber open, tap the question 
mark in the lower right hand corner of the screen. 

To select typed text: 
If you want to edit or format typed text, you must select it first. 
■ Drag the stylus across the text you want to select. 
You can cut, copy, and paste text by tapping and holding the selected words and then 
tapping an editing command on the pop-up menu, or by tapping the command on the 
Edit menu. 

Writing on the Screen 
In any program that accepts writing, such as the Notes program and the Notes tab in 
Calendar, Contacts, and Tasks, you can use your stylus to write directly on the 
screen. Write the way you do on paper. You can edit and format what you’ve written 
and convert the information to text at a later time. 
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To write on the screen: 
■ Tap the Pen button to switch to writing mode. This action displays lines on the 

screen to help you write. 

 

Some programs that accept writing may not have the Pen button. See the 
documentation for that program to find out how to switch to writing mode. 

To select writing: 
If you want to edit or format writing, you must select it first. 
1. Tap and hold the stylus next to the text you want to select until the insertion point 

appears. 
2. Without lifting, drag the stylus across the text you want to select. 
If you accidentally write on the screen, tap Tools, then Undo and try again. You can 
also select text by tapping the Pen button to deselect it and then dragging the stylus 
across the screen. 
You can cut, copy, and paste written text in the same way you work with typed text: 
tap and hold the selected words and then tap an editing command on the pop-up 
menu, or tap the command on the Edit menu. 

  

Tap the Pen button and use your  
stylus like a pen. 
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To convert writing to text: 
■ Tap Tools and then Recognize. 
If you want to convert only certain words, select them before tapping Recognize on 
the Tools menu (or tap and hold the selected words and then tap Recognize on the 
pop-up menu). If a word is not recognized, it is left as writing. 

 

 
The writing is  
turned into  
text. 

 
Select the text you want to convert  
and Tap Recognize on the pop-up menu. 
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If the conversion is incorrect, you can select different words from a list of alternates or 
return to the original writing. To do so, tap and hold the incorrect word (tap one word 
at a time). On the pop-up menu, tap Alternates. A menu with a list of alternate words 
appears. Tap the word you want to use, or tap the writing at the top of the menu to 
return to the original writing. 

 

Tips for getting good recognition: 
■ Write neatly. 
■ Write on the lines and draw descenders below the line. Write the cross of the “t” 

and apostrophes below the top line so that they are not confused with the word 
above. Write periods and commas above the line. 

■ For better recognition, try increasing the zoom level to 300% using the Tools 
menu. 

■ Write the letters of a word closely and leave big gaps between words so that the 
Toshiba Pocket PC can easily tell where words begin and end. 

■ Hyphenated words, foreign words that use special characters such as accents, 
and some punctuation cannot be converted. 

■ If you add writing to a word to change it (such as changing a “3” to an “8”) after 
you attempt to recognize the word, the writing you add will not be included if you 
attempt to recognize the writing again.  

Tap to return to your original writing. 

Or, tap the word you want to use. 
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Drawing on the Screen 
You can draw on the screen in the same way that you write on the screen. The 
difference between writing and drawing on the screen is how you select items and 
how they can be edited. For example, selected drawings can be resized, while writing 
cannot. 

To create a drawing: 
■ Cross three ruled lines on your first stroke. A drawing box appears. Subsequent 

strokes in or touching the drawing box become part of the drawing. Drawings that 
do not cross three ruled lines will be treated as writing. 

 

You may want to change the zoom level so that you can more easily work on or view 
your drawing. Tap Tools and then a zoom level. 

To select a drawing: 
If you want to edit or format a drawing, you must select it first. 
■ Tap and hold the stylus on the drawing until the selection handle appears. To 

select multiple drawings, deselect the Pen button and then drag to select the 
drawings you want. 

You can cut, copy, and paste selected drawings by tapping and holding the selected 
drawing and then tapping an editing command on the pop-up menu, or by tapping the 
command on the Edit menu. To resize a drawing, make sure the Pen button is not 
selected, and drag a selection handle. 

  

Pen button. 

The drawing box indicates the  
boundaries of the drawing. 
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Recording a Message 
In any program where you can write or draw on the screen, you can also quickly 
capture thoughts, reminders, and phone numbers by recording a message. In 
Calendar, Tasks, and Contacts, you can include a recording in the Notes tab. In the 
Notes program, you can either create a stand-alone recording or include a recording 
in a written note. If you want to include the recording in a note, open the note first. In 
the Inbox program, you can add a recording to an e-mail message.  

To create a recording:  
1. Hold your Toshiba Pocket PC’s microphone near your mouth or other source of 

sound. 
2. Press and hold the Record button on your Toshiba Pocket PC until you hear a 

beep. 
3. While holding down the Record button, make your recording. 
4. To stop recording, release the Record button. Two beeps will sound. The new 

recording appears in the note list or as an embedded icon. 

You can also make a recording by tapping the Record button on the Recording 
toolbar. 

To play a recording, tap it in the list or tap its icon in the note. 

 

  

Indicates an embedded recording. 

Tap to show or hide the Recording  
toolbar. 

Tap to begin recording. 
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Using My Text 
When using Inbox or MSN Messenger, use My Text to quickly insert preset or 
frequently used messages into the text entry area. To insert a message, tap My Text 
and tap a message. 

 

You can add text after inserting a My Text message before sending it. 

To edit a My Text message, in the Tools menu, tap Edit and then tap My Text 
Messages. Select the message you wish to edit and make desired changes. 

  

Tap to select a prewritten message. 
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Find and Organize Information 
The Find feature on your Toshiba Pocket PC helps you quickly locate information.  
■ On the  menu, tap Find. Enter the text you want to find, select a data type, 

and then tap Go to start the search. 

To quickly find information that is taking up storage space on your Toshiba Pocket PC, 
select Larger than 64 KB in Type. 

You can also use the File Explorer to find files on your Toshiba Pocket PC and to 
organize these files into folders. On the  menu, tap Programs, and then File 
Explorer. 

 

You can move files in File Explorer by tapping and holding the item you want to move, 
and then tapping Cut or Copy and Paste on the pop-up menu. 

  

  

Select the sort order for the list. 

Tap to change folders. 

Tap and hold to create a new folder. 

Tap the folder name to open it. 
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Customize Your Toshiba Pocket PC 
You can customize your Toshiba Pocket PC by adjusting the settings and installing 
additional software. 

Adjusting Settings 
You can adjust device settings to suit your preferences. To see available options, tap 

, Settings, then the Personal or System tab located at the bottom of the screen. 
You might want to adjust the following: 
■ Adding or Removing Programs 
■ Password 
■ Front Light 
■ Power 
■ Memory 

Adding or Removing Programs 
Programs added to your Toshiba Pocket PC at the factory are stored in ROM (read-
only memory). You cannot remove this software, and you’ll never accidentally lose 
ROM contents. ROM programs can be updated using special installation programs 
with a *.xip extension. All other programs and data files added to your Toshiba Pocket 
PC after factory installation are stored in RAM (random access memory).  
You can install any program created for your Toshiba Pocket PC, as long as your 
Toshiba Pocket PC has enough memory. The most popular place to find software for 
your Toshiba Pocket PC is on the Toshiba Pocket PC Web site 
(http://www.microsoft.com/mobile/pocketpc). 

If you update ROM programs using special installation programs with a *.xip 
extension, do not use the backup data which you made before updating ROM 
programs. 

To add programs using ActiveSync: 
You’ll need to install the appropriate software for your Toshiba Pocket PC on your 
computer before installing it on your Toshiba Pocket PC. 
1. Determine your Toshiba Pocket PC and processor type so that you know which 

version of the software to install. Tap  and then Settings. On the System tab, 
tap About. In the Version tab, make a note of the information in Processor.  

2. Download the program to your computer (or insert the CD or disk that contains 
the program into your computer). You may see a single *.xip, *.exe, or *.zip file, a 
Setup.exe file, or several versions of files for different Toshiba Pocket PC types 
and processors. Be sure to select the program designed for the Toshiba Pocket 
PC and your Toshiba Pocket PC processor type. 
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3. Read any installation instructions, Read Me files, or documentation that comes 
with the program. Many programs provide special installation instructions. 

4. Connect your Toshiba Pocket PC and computer. 
5. Double-click the *.exe file. 
■ If the file is an installer, the installation wizard will begin. Follow the directions on 

the screen. Once the software has been installed on your computer, the installer 
will automatically transfer the software to your Toshiba Pocket PC.  

■ If the file is not an installer, you will see an error message stating that the program 
is valid but it is designed for a different type of computer. You will need to move 
this file to your Toshiba Pocket PC. If you cannot find any installation instructions 
for the program in the Read Me file or documentation, use ActiveSync Explore to 
copy the program file to the Program Files folder on your Toshiba Pocket PC. For 
more information on copying files using ActiveSync, see ActiveSync Help.  

Once installation is complete, tap , Programs, and then the program icon to switch 
to it. 

To add a program directly from the Internet: 
1. Determine your Toshiba Pocket PC and processor type so that you know which 

version of the software to install. 
 Tap  and then Settings. On the System tab, tap About. In the Version tab, 

make a note of the information in Processor.  
2. Download the program to your Toshiba Pocket PC straight from the Internet using 

Pocket Internet Explorer. You may see a single *.xip, *.exe or *.zip file, a 
Setup.exe file, or several versions of files for different device types and 
processors. Be sure to select the program designed for the Toshiba Pocket PC 
and your Toshiba Pocket PC processor type. 

3. Read any installation instructions, Read Me files, or documentation that comes 
with the program. Many programs provide special installation instructions. 

4. Tap the file, such as a *.xip or *.exe file. The installation wizard will begin. Follow 
the directions on the screen. 
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For more information see Ch.7 Getting Connected. 

To add a program to the Start menu: 
Tap , Settings, Menus, the Start Menu tab, and then the check box for the 
program. If you do not see the program listed, you can either use File Explorer on the 
Toshiba Pocket PC to move the program to the Start Menu folder or use ActiveSync 
on the computer to create a shortcut to the program and place the shortcut in the Start 
Menu folder. 
■ Using File Explorer on the Toshiba Pocket PC: Tap , Programs, File 

Explorer, and locate the program (tap the folder list, labeled My Documents by 
default, and then My Device to see a list of all folders on the Toshiba Pocket PC). 
Tap and hold the program and tap Cut on the pop-up menu. Open the Start Menu 
folder located in the Windows folder, tap and hold a blank area of the window, and 
tap Paste on the pop-up menu.  

 The program will now appear on the  menu. For more information on using File 
Explorer, see “Find and Organize Information,” earlier in this chapter. 

■ Using ActiveSync on the computer: Use the Explorer in ActiveSync to explore 
your Toshiba Pocket PC files and locate the program. Right-click the program, 
and then click Create Shortcut. Move the shortcut to the Start Menu folder in the 
Windows folder. The shortcut now appears on the  menu. For more 
information, see ActiveSync Help. 

To remove programs 
■ Tap  and then Settings. On the System tab, tap Remove Programs. 
If the program does not appear in the list of installed programs, use File Explorer on 
your Toshiba Pocket PC to locate the program, tap and hold the program, and then 
tap Delete on the pop-up menu. 

Setting Password 
You can protect data or settings from a third person by setting a password, which is 
requested when turning power on. 
1. Tap  and then Settings. On the Personal tab, tap Password. 
2. Select the type of password you would like to use. 
3. Enter a password and tap OK. 
4. Tap YES on the confirmation screen. The password is saved and the screen 

returns to the Personal tab screen 

If you tap YES on the confirmation screen to return to the Personal tab screen, it 
becomes necessary to enter the password even for displaying the Password setting 
screen. 
In case you forget the password, it is necessary to initialize the Toshiba Pocket PC. 
Please note that when initialization is executed, data or settings stored in the Toshiba 
Pocket PC are all deleted. 
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To Set Front Light 
You can set the screen brightness for better sight according to a place of use. You can 
also set the time that elapses until the front light turns off automatically after the last 
operation. 
1. Tap  and then Settings. On the System tab, tap Front Light. 
2. Set the Front Light. 

 

3. When finished, tap OK to return to the System tab screen. 

Check to make the front light turn off  
automatically when the Toshiba Pocket PC  
hasn’t been used for a user-set  
amount of time.  

Set the time that elapses until the  
front light turns off automatically. 

Check to make the front light turn off  
automatically when the AC adapter  
(external power) is in use. 

Tap and set the front light brightness  
level from the list. If Power Save is  
activated, the front light turns off.  
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Setting Power 
You can set to confirm the remaining battery power and the time that elapses until the 
power turns off after the last operation. 
1. Tap  and then Settings. On the System tab, tap Power. 
2. Set the Power.  

 

3. When finished, tap OK to return to the System tab screen. 

Setting Memory 
You can adjust the data storing memory and the program running memory. You can 
also confirm the free space of a storage card and so on. Memory for the Toshiba 
Pocket PC is managed automatically. 

To change Memory allocation: 
1. Tap  and then Settings. On the System tab, tap Memory to display the 

Memory setting screen. 
2. Drag the knob left to right to adjust the memory allocation between Storage and 

Program. 
3. When finished, tap OK to return to the System tab screen. 

Displays the built-in battery  
remaining power. 

Check to make the power turn off 
 automatically when the Toshiba Pocket PC  
hasn’t been used for a user-set  
amount of time. 

Set the time that elapses until the power turns off 
automatically. 

Check to make the power turn off  
automatically when the AC adapter  
(external power) is in use. 

Check here to make the power be  
supplied to the CF card even  
when suspend is on. 
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To confirm usage status of a storage card: 
1. Tap Storage card tab on the Memory setting screen. 

 

2. When finished, tap OK to return to the System tab screen. 

If storage cards are inserted both in the CF card slot and the SD card slot, the usage 
status is displayed only for the card inserted first. 

To release memory: 
If memory is running short of its capacity, i.e., error message display, the following 
methods are available to release the memory.  
■ Transfer data to a storage card and delete them from the Toshiba Pocket PC. 
■ Delete unnecessary files. 
■ Quit a program in execution.  
■ Delete a program not in use. 
 

For more information on detailed operation method or the memory release method 
other than the above, see online help. 

 

  

  

Capacity of a storage card  
being inserted. 

Capacity in use. 

Free space. 
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Chapter 3 

Microsoft ActiveSync 

Using Microsoft® ActiveSync®, you can synchronize the information on your computer 
with the information on your Toshiba Pocket PC. Synchronization compares the data 
on your Toshiba Pocket PC with your computer and updates both computers with the 
most recent information. For example: 
■ Keep Pocket Outlook data up-to-date by synchronizing your Toshiba Pocket PC 

with Microsoft Outlook data on your computer.  
■ Synchronize Microsoft Word and Microsoft Excel files between your Toshiba 

Pocket PC and computer. Your files are automatically converted to the correct 
format.  

By default, ActiveSync does not automatically synchronize all types of information. 
Use ActiveSync options to turn synchronization on and off for specific information 
types. 

With ActiveSync, you can also: 
■ Back up and restore your Toshiba Pocket PC data.  
■ Copy (rather than synchronize) files between your Toshiba Pocket PC and 

computer.  
■ Control when synchronization occurs by selecting a synchronization mode. For 

example, you can synchronize continually while connected to your computer or 
only when you choose the synchronize command. 

■ Select which information types are synchronized and control how much data is 
synchronized. For example, you can choose how many weeks of past 
appointments you want synchronized. 

Before you begin synchronization, install ActiveSync on your computer from the 
Toshiba Pocket PC Companion CD. For more information on installing ActiveSync, 
see your Quick Start card. ActiveSync is already installed on your Toshiba Pocket PC. 

 

TOSHIBA Pocket PC e570 
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After installation is complete, the ActiveSync Setup Wizard helps you connect your 
Toshiba Pocket PC to your computer, set up a partnership so you can synchronize 
information between your Toshiba Pocket PC and your computer, and customize your 
synchronization settings. Your first synchronization process will automatically begin 
when you finish using the wizard. 
After your first synchronization, take a look at Calendar, Contacts, and Tasks on your 
Toshiba Pocket PC. You’ll notice that information you’ve stored in Microsoft Outlook 
on your computer has been copied to your Toshiba Pocket PC and you didn’t have to 
type a word. Disconnect your Toshiba Pocket PC from your computer and you’re 
ready to go! 
Once you have set up ActiveSync and completed the first synchronization process, 
you can initiate synchronization from your Toshiba Pocket PC. To switch to ActiveSync 
on your Toshiba Pocket PC, tap , and then tap ActiveSync. 
Note that if you have a wireless LAN card, you can synchronize remotely from your 
Toshiba Pocket PC. 
For information about using ActiveSync on your computer, start ActiveSync on your 
computer, and then see ActiveSync Help. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Tap to synchronize via IR or change  
synchronization settings. 

Tap to connect and synchronize. 

Tap to stop synchronization. 

View connection status. 

View synchronization status. 
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Chapter 4 

Microsoft Pocket Outlook 

Microsoft® Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes. You 
can use these programs individually or together. For example, e-mail addresses 
stored in Contacts can be used to address e-mail messages in Inbox.  
Using ActiveSync®, you can synchronize information in Microsoft Outlook or Microsoft 
Exchange on your computer with your Toshiba Pocket PC. You can also synchronize 
this information directly with a Microsoft Exchange server. Each time you synchronize, 
ActiveSync compares the changes you made on your Toshiba Pocket PC and 
computer or server and updates both computers with the latest information. For 
information on using ActiveSync, see ActiveSync Help on the computer. 
You can switch to any of these programs by tapping them on the  menu. 

 

TOSHIBA Pocket PC e570 

 User’s Guide 4-1 



 Microsoft Pocket Outlook  

User’s Guide  4-2  

Version   1   Last Saved on 10/18/2001 2:28 PM 

TOSHIBA Pocket PC e570  – Ppc_e570.doc – ENGLISH – Printed on 10/18/2001 as 01_GENUK 

Calendar: Scheduling Appointments and Meetings 
Use Calendar to schedule appointments, including meetings and other events. You 
can check your appointments in one of several views (Agenda, Day, Week, Month, 
and Year) and easily switch views by tapping one of the 5 view icons at the bottom of 
the screen or by pressing the Calendar Program (button #1 on front of Toshiba Pocket 
PC). 

 

You can customize the Calendar display, such as changing the first day of the week, 
by tapping Options on the Tools menu.    

Tap to create a new appointment. 

Tap to display or edit the  
appointment details. 

Tap to go to today. 
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To create an appointment: 
If you are in Day or Week view, tap the desired date and time for the appointment. 
1. Tap New. 

 

2. Using the input panel, enter a description and a location. Tap first to select the 
field.  

3. If needed, tap the date and time to change them. 
4. Enter other desired information. You will need to hide the input panel to see all 

available fields. 
5. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. 

For more information on creating notes, see “Notes: Capturing Thoughts and 
Ideas,” later in this chapter. 

6. When finished, tap OK to return to the calendar.  

If you select Remind me in an appointment, your Toshiba Pocket PC will remind you 
according to the options set in, Settings, Personal tab, Sounds & Notifications.    

Tap to select a date. 

Tap to select a time. 

Notes is a good place for maps  
and directions. 

Tap to choose from predefined text. 

Tap to return to the calendar (the  
appointment is saved automatically). 

Tap to choose from previously  
entered locations. 
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Using the Summary Screen 
When you tap an appointment in Calendar, a summary screen is displayed. To 
change the appointment, tap Edit. 

 

Creating Meeting Requests 
You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. 
The meeting request will be created automatically and sent either when you 
synchronize Inbox or when you connect to your e-mail server. Indicate how you want 
meeting requests sent by tapping Tools and then Options. If you send and receive e-
mail messages through ActiveSync, select ActiveSync. 

To schedule a meeting: 
1. Create an appointment. 
2. In the appointment details, hide the input panel, and then tap Attendees. 
3. From the list of e-mail addresses you’ve entered in Contacts, select the meeting 

attendees.  
The meeting notice is created automatically and placed in the Outbox folder. 
For more information on sending and receiving meeting requests, see Calendar Help 
and Inbox Help on the Toshiba Pocket PC. 

Tap to change appointment. 

View. 

View appointment details. 
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Contacts: Tracking Friends and Colleagues 
Contacts maintains a list of your friends and colleagues so that you can easily find the 
information you’re looking for, whether you’re at home or on the road. Using the 
Toshiba Pocket PC infrared (IR) port, you can quickly share Contacts information with 
other device users. 

 

To change the way information is displayed in the list, tap Tools and then Options. 
  

Select the category of contacts you  
want displayed in the list. 

Tap to create a new contact. 

Tap and hold to display a pop-up  
menu of actions. 

Tap to display or edit the contact details. 

Tap to see additional phone numbers  
and e-mail addresses. 

Tap and enter part of a name to quickly  
find it in the list. 
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To create a contact: 
1. Tap New. 

 

2. Using the input panel, enter a name and other contact information. You will need 
to scroll down to see all available fields. 

3. To assign the contact to a category, scroll to and tap Categories and select a 
category from the list. In the contact list, you can display contacts by category. 

4. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. 
For more information on creating notes, see “Notes: Capturing Thoughts and 
Ideas,” later in this chapter. 

5. When finished, tap OK to return to the contact list. 

Finding a contact 
There are four ways to find a contact:  
■ In the contact list, enter a contact name in the box under the navigation bar. To 

show all contacts again, clear text from the box or tap the button to the right of the 
box.  

■ In the contact list, tap the category list (labeled All Contacts by default) and 
select the type of contact that you want displayed. To show all contacts again, 
select All Contacts. To view a contact not assigned to a category, select None.  

■ To view the names of companies your contacts work for, in the contact list, tap 
View > By Company. The number of contacts that work for that company will be 
displayed to the right of the company name.  

■ Tap , Find, enter the contact name, select Contacts for the type, and then tap 
Go.  

Notes is a good place for maps  
and directions. 

Scroll to see more fields. 

Tap to return to the contact list (the  
contact is saved automatically). 
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Using the Summary Screen 
When you tap a contact in the contact list, a summary screen is displayed. To change 
the contact information, tap Edit. 

 

Tap to change contact information. 

Tap to view notes. 

View contact details. 
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Tasks: Keeping a To Do List 
Use Tasks to keep track of what you have to do.  

 

To change the way information is displayed in the list, tap Tools and then Options. 
  

Select the category of tasks you  
want displayed in the list. 

Tap to create a new task. 

Tap and hold to display a pop-up  
menu of actions. 

Tap to display or edit the task details. 

Indicates high priority. 

Select the sort order of the list. 
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To create a task: 
1. Tap New. 

 

2. Using the input panel, enter a description. 
3. You can enter a start date and due date or enter other information by first tapping 

the field. If the input panel is open, you will need to hide it to see all available 
fields. 

4. To assign the task to a category, tap Categories and select a category from the 
list. In the task list, you can display tasks by category. 

5. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. 
For more information on creating notes, see “Notes: Capturing Thoughts and 
Ideas,” later in this chapter. 

6. When finished, tap OK to return to the task list. 

To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, 
tap Tap here to add a new task and enter your task information.   

Notes is a good place for maps and  
drawings. 

Tap to choose from predefined  
subjects. 

Tap to return to the task list (the task 
 is saved automatically). 
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Using the Summary Screen 
When you tap a task in the task list, a summary screen is displayed. To change the 
task, tap Edit. 

 

Tap to change task. 

View notes. 

Tap to show and hide additional  
summary information. 

View task details. 
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Notes: Capturing Thoughts and Ideas 
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with 
Notes. You can create a written note or a recording. You can also include a recording 
in a note. If a note is open when you create the recording, it will be included in the 
note as an icon. If the note list is displayed, it will be created as a stand-alone 
recording. 

 Tap to create a new item. 

Tap to show or hide the Recording  
toolbar. 

Tap to record. 

Tap and hold to display a pop-up  
menu of actions. 

Tap to open a note or play a recording. 

Tap to change the sort order of the list. 
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To create a note: 
1. Tap New. 
2. Create your note by writing, drawing, typing, and recording. For more information 

about using the input panel, writing and drawing on the screen, and creating 
recordings, see Chapter 2. 

 

Inbox: Sending and Receiving E-mail Messages 
Use Inbox to send and receive e-mail messages in either of these ways:  
■ Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on 

your computer. 
■ Send and receive e-mail messages by connecting directly to an e-mail server 

through an Internet service provider (ISP) or a network. 

Synchronizing E-mail Messages 
E-mail messages can be synchronized as part of the general synchronization 
process. You will need to enable Inbox synchronization in ActiveSync. For information 
on enabling Inbox synchronization, see ActiveSync Help on the computer. 
During synchronization: 

Tap to add a recording to the note. 

Tap to show or hide the input panel. 

Tap to write on the screen. 

Tap to return to the note list  
(the note is saved automatically). 
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■ Messages are copied from the mail folders of Exchange or Outlook on your 
computer to the ActiveSync folder in Inbox on your Toshiba Pocket PC. By 
default, you will receive messages from the past five days only, the first 100 lines 
of each message, and file attachments of less than 100 KB in size. 

■ E-mail messages in the Outbox folder on your Toshiba Pocket PC are transferred 
to Exchange or Outlook, and then sent from those programs. 

■ E-mail messages in subfolders must be selected in ActiveSync on your computer 
in order to be transferred. 

You can also synchronize e-mail messages with your computer from a remote 
location. For more information, see Chapter 7. 

Connecting Directly to an E-mail Server 
In addition to synchronizing e-mail messages with your computer, you can send and 
receive e-mail messages by connecting to an e-mail server using a modem or your 
wireless phone connected to your Toshiba Pocket PC. You’ll need to set up a remote 
connection to a network or an ISP, and a connection to your e-mail server. For more 
information, see Chapter 7. 
When you connect to the e-mail server, new messages are downloaded to the 
Toshiba Pocket PC Inbox folder, messages in the Toshiba Pocket PC Outbox folder 
are sent, and messages that have been deleted on the e-mail server are removed 
from the Toshiba Pocket PC Inbox folder. 
Messages that you receive directly from an e-mail server are linked to your e-mail 
server rather than your computer. When you delete a message on your Toshiba 
Pocket PC, it is also deleted from the e-mail server the next time you connect based 
on the settings you selected in ActiveSync. 
You can work online or offline. When working online, you read and respond to 
messages while connected to the e-mail server. Messages are sent as soon as you 
tap Send, which saves space on your Toshiba Pocket PC. 
When working offline, once you’ve downloaded new message headers or partial 
messages, you can disconnect from the e-mail server and then decide which 
messages to download completely. The next time you connect, Inbox downloads the 
complete messages you’ve marked for retrieval and sends the messages you’ve 
composed. 
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Using the Message List 
Messages you receive are displayed in the message list. By default, the most recently 
received messages are displayed first in the list. 

 

When you receive a message, tap it to open it. Unread messages are displayed in 
bold. 

 

Select the service and folder you  
want to display. 

Tap to connect and to send and  
receive e-mail. 

Tap to connect to the selected service. 

Tap and hold to display a pop-up  
menu of actions. 

Select the sort order for messages. 

Tap to view the previous or  
next message. 

Tap to reply or to forward  
this message. 

Tap to delete this message. 

Tap to return to the message list. 
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When you connect to your e-mail server or synchronize with your computer, by 
default, you’ll receive messages from the last five days only, the first 100 lines of each 
new message, and file attachments of less than 100 KB in size. The original 
messages remain on the e-mail server or your computer.  
You can mark the messages that you want to retrieve in full during your next 
synchronization or  
e-mail server connection. In the message list, tap and hold the message you want to 
retrieve. On the pop-up menu, tap Mark for Download. The icons in the Inbox 
message list give you visual indications of message status. 
You specify your downloading preferences when you set up the service or select your 
synchronization options. You can change them at any time: 
■ Change options for Inbox synchronization using ActiveSync options. For more 

information, see ActiveSync Help. 
■ Change options for direct e-mail server connections in Inbox on your Toshiba 

Pocket PC. Tap Tools and then tap Options. On the Service tab, tap the service 
you want to change. Tap and hold the service and select Delete to remove a 
service. 
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Composing Messages 

To compose a message: 
1. Tap New.  
2. In the To field, enter an e-mail address of one or more recipients, separating them 

with a semicolon, or select a name from the contact list by tapping the Address 
Book button.  

 All e-mail addresses entered in the e-mail fields in Contacts appear in the 
Address Book. 

 

3. Compose your message. To enter preset or frequently used messages, tap My 
Text and select a message. 

4. Tap Send when you’ve finished the message. If you are working offline, the 
message is moved to the Outbox folder and will be sent the next time you 
connect. 

Managing E-mail Messages and Folders 
By default, messages are displayed in one of five folders for each service you have 
created: Inbox, Deleted Items, Drafts, Outbox, and Sent Items. The Deleted Items 
folder contains messages that have been deleted on the Toshiba Pocket PC. The 
behavior of the Deleted and Sent Items folders depends on the options you have 
chosen. In the message list, tap Tools and then Options. On the Message tab, select 
your options. 

Tap to send the message. 

Tap to show/hide the recording  
toolbar. 

Tap to display the address book. 

Tap to insert common message. 

Tap to show or hide the  
complete header. 
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If you want to organize messages into additional folders, tap Tools, and then Manage 
Folders to create new folders. To move a message to another folder, in the message 
list, tap and hold the message and then tap Move to on the pop-up menu. 

Folder behavior with a direct connection to an e-mail 
server 
The behavior of the folders you create depends on whether you are using ActiveSync, 
POP3, or IMAP4: 
■ If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will 

automatically be synchronized with your Toshiba Pocket PC. You can select to 
synchronize additional folders by designating them for ActiveSync. The folders 
you create and the messages you move will then be mirrored on the server. For 
example, if you move two messages from the Inbox folder to a folder named 
Family, and you have designated Family for synchronization, the server creates a 
copy of the Family folder and copies the messages into that folder. You can then 
read the messages while away from your computer. 

■ If you use POP3 and you move e-mail messages to a folder you created, the link 
is broken between the messages on the Toshiba Pocket PC and their copies on 
the mail server. The next time you connect, the mail server will see that the 
messages are missing from the Toshiba Pocket PC Inbox and delete them from 
the server. This prevents you from having duplicate copies of a message, but it 
also means that you will no longer have access to messages that you move to 
folders created from anywhere except the Toshiba Pocket PC. 

■ If you use IMAP4, the folders you create and the e-mail messages you move are 
mirrored on the server. Therefore, messages are available to you anytime you 
connect to your mail server, whether it is from your Toshiba Pocket PC or 
computer. This synchronization of folders occurs whenever you connect to your 
mail server, create new folders, or rename/delete folders when connected. 
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Chapter 5 

Companion Programs 

The companion programs consist of Microsoft® Pocket Word, Microsoft® Pocket 
Excel, Windows MediaTM Player for Toshiba Pocket PC, and Microsoft® Reader.  
To switch to a companion program on your Toshiba Pocket PC, tap Programs on the 

 menu, and then tap the program name. 

Pocket Word 
Pocket Word works with Microsoft Word on your computer to give you easy access to 
copies of your documents. You can create new documents on your Toshiba Pocket 
PC, or you can copy documents from your computer to your Toshiba Pocket PC. 
Synchronize documents between your computer and your Toshiba Pocket PC so that 
you have the most up-to-date content in both locations. 
Use Pocket Word to create documents, such as letters, meeting minutes, and trip 
reports. To create a new file, tap, Programs, Pocket Word, and then New. A blank 
document appears. Or, if you’ve selected a template for new documents in the 
Options dialog box, that template appears with appropriate text and formatting 
already provided. You can open only one document at a time; when you open a 
second document, you’ll be asked to save the first. You can save a document you 
create or edit in a variety of formats, including Word (.doc), Pocket Word (.psw), Rich 
Text Format (.rtf), and Plain Text (.txt).  
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Pocket Word contains a list of the files stored on your Toshiba Pocket PC. Tap a file in 
the list to open it. To delete, make copies of, and send files, tap and hold a file in the 
list. Then, select the appropriate action on the pop-up menu. 

 

You can enter information in Pocket Word in one of four modes (typing, writing, 
drawing, and recording), which are displayed on the View menu. Each mode has its 
own toolbar, which you can show and hide by tapping the Show/Hide Toolbar button 
on the command bar. 

You can change the zoom magnification by tapping View and then Zoom. Then select 
the percentage you want. Select a higher percentage to enter text and a lower one to 
see more of your document. 
If you’re opening a Word document created on a computer, select Wrap to Window 
on the View menu so that you can see the entire document. 

  

Select the type of folder you want  
displayed in the list. 

Tap to create a new document. 

Tap and hold an item to display a  
pop-up menu of actions. 

Tap to open a document. 

Tap to change the sort order of the list. 
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Typing Mode 
Using the input panel, enter typed text into the document. For more information on 
entering typed text, see Chapter 2. 
To format existing text and to edit text, first select the text. You can select text as you 
do in a Word document, using your stylus instead of the mouse to drag through the 
text you want to select. You can search a document to find text by tapping Edit and 
then Find/Replace. 

 

Tap and hold to see a pop-up menu 
 of actions. 

Tap to change formatting options. 

Tap to show or hide the toolbar. 

Tap to format text. 

Tap to return to the document  
(changes are saved automatically). 
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Writing Mode 
In writing mode, use your stylus to write directly on the screen. Ruled lines are 
displayed as a guide, and the zoom magnification is greater than in typing mode to 
allow you to write more easily. For more information on writing and selecting writing, 
see Chapter 2. 

 

If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, 
and can be edited and manipulated as described in the following section. 
Written words are converted to graphics (metafiles) when a Pocket Word document is 
converted to a Word document on your computer. 

  

Tap to highlight selected text. 

Space button. 

Pen button. 

With Space button selected, drag  
to insert space. An arrow appears  
showing the space direction and size. 
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Drawing Mode 
In drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. 
When you lift your stylus off the screen after the first stroke, you’ll see a drawing box 
indicating the boundaries of the drawing. Every subsequent stroke within or touching 
the drawing box becomes part of the drawing. For more information on drawing and 
selecting drawings, see Chapter 2. 

 

Recording Mode 
In recording mode, you can embed a recording into your document. Recordings are 
saved as .wav files. For more information on recording, see Chapter 2. 
For more information on using Pocket Word, tap  and then Help. 

Tap to select formatting options, such  
as line weight, fill colour, and  
line colour. 

Tap an arrow to see your choices. 

Pen button. 

Resize an object by dragging the  
selection handles. 
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Pocket Excel 
Pocket Excel works with Microsoft Excel on your computer to give you easy access to 
copies of your spreadsheets. You can create new spreadsheet on your Toshiba 
Pocket PC, or you can copy spreadsheets from your computer to your Toshiba Pocket 
PC. Synchronize spreadsheets between your computer and your Toshiba Pocket PC 
so that you have the most up-to-date content in both locations. 
Use Pocket Excel to create spreadsheets, such as expense reports and mileage logs. 
To create a new file, tap, Programs, Pocket Excel, and then New. A blank 
spreadsheet appears. Or, if you’ve selected a template for new spreadsheets in the 
Options dialog box, that template appears with appropriate text and formatting 
already provided. You can open only one file at a time; when you open a second file, 
you’ll be asked to save the first. You can save a spreadsheet you create or edit in a 
variety of formats, including Pocket Excel (.pxl) and Excel (.xls). 
Pocket Excel contains a list of the files stored on your Toshiba Pocket PC. Tap a file in 
the list to open it. To delete, make copies of, and send files, tap and hold a file in the 
list. Then select the appropriate action from the pop-up menu. 
Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, 
sorting, and filtering. To display the toolbar, tap View and then Toolbar.  

 

If your spreadsheet contains sensitive information, you can protect it with a password. 
To do so, open the file, tap Edit, and then Password. Every time you open that file, 
you will need to enter the password. Be sure to choose on that is easy for you to 
remember but hard for others to guess. 

  

Zoom button. 

Format button. 

AutoSum button. 

Cell contents appear here as you  
enter them. 
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Tips for Working in Pocket Excel 
Note the following when work in large spreadsheets in Pocket Excel: 
■ View in full-screen mode to see as much of your spreadsheet as possible. Tap 

View and then Full Screen. To exit full-screen mode, tap Restore. 
■ Show and hide window elements. Tap View and then tap the elements you want 

to show or hide. 
■ Freeze panes on a spreadsheet. First select the cell where you want to freeze 

panes. Tap View and then Freeze Panes. You might want to freeze the top and 
leftmost panes in a spreadsheet to keep row and column labels visible as you 
scroll through a sheet. 

■ Split panes to view different areas of a large spreadsheet. Tap View and then 
Split. Then drag the split bar to where you want it. To remove the split, tap View 
and then Remove Split. 

■ Show and hide rows and columns. To hide a hidden row or column, select a cell 
in the row or column you want to hide. Then tap Format, then Row or Column, 
then Hide. To show a hidden row or column, tap Tools, then Go To, and then 
type a reference that is in the hidden row or column. Then tap Format, then Row 
or Column, and then Unhide. 

For more information on using Pocket Excel, tap  and then Help. 

MSN Messenger 
MSN® Messenger on your mobile Toshiba Pocket PC is an instant messaging 
program that lets you: 
■ View a list of Instant messaging contacts who are online. 
■ Send and receive instant messages. 
■ Have instant message conversations with groups of contacts. 
To use MSN Messenger, you must have a Microsoft PassportTM account or a 
Microsoft Exchange e-mail account. If you have a Hotmail® or MSN account, you 
already have a Passport. Once you have obtained either a Microsoft Passport or a 
Microsoft Exchange account, you are ready to set up your account. 

Sign up for a Microsoft Passport account at http://www.passport.com. Get a free 
Microsoft Hotmail e-mail address at http://www.hotmail.com. 

To switch to MSN Messenger, tap , Programs, and then tap MSN Messenger. 

Setting Up 
Before you can connect, you must enter Passport or Exchange account information. 

To set up an account and sign in: 
1. In the Tools menu, tap Options. 
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2. On the Accounts tab, enter your Passport or Exchange account information. 
3. To sign in, tap the sign-in screen and enter your e-mail address and password. 

If you already use MSN Messenger on your computer, your contacts will show up on 
your Toshiba Pocket PC without having to be added again. 

Working with Contacts 
The MSN Messenger window shows all of your messenger contacts at a glance, 
divided into Online and Not Online categories. From this view, while connected, you 
can chat, send an e-mail, block the contact from chatting with you, or delete contacts 
from your list using the pop-up menu. 

 

To see others online without being seen, in the Tools menu, tap My Status and select 
Appear Offline. 

If you block a contact, you will appear offline but will remain on the blocked contact’s 
list. To unblock a contact, tap and hold the contact, then tap Unblock on the pop-up 
menu. 

  

  

Tap and hold to see a pop-up  
menu of actions. 

Tap a contact to start a chat. 
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Chatting with Contacts 
Tap a contact name to open a chat window. Enter your message in the text entry area 
at the bottom of the screen, or tap My Text to enter a preset message, and tap Send. 
To invite another contact to a multi-user chat, in the Tools menu, tap Invite and tap 
the contact you wish to invite. 

 

To switch back to the main window without closing a chat, tap the Contacts button. To 
revert back to your chat window, tap Chats and select the person whom you were 
chatting with. 

  

Tap to send message. 

Enter message here. 
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To know if the contact you are chatting with is responding, look for the message under 
the text entry area. 

 

For more information on using MSN Messenger, tap  and then Help. 

View status of the chat. 

View full chat. 
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Windows Media Player for Toshiba Pocket PC 
Use Microsoft Windows Media Player for Toshiba Pocket PC to play digital audio and 
video files that are stored on your Toshiba Pocket PC or on a network. To switch to 
Windows Media Player for Toshiba Pocket PC, tap , Programs, and then tap 
Windows Media. 

 

Use Microsoft Windows Media Player on your computer to copy digital audio and 
video files to your Toshiba Pocket PC. You can play Windows Media and MP3 files on 
your Toshiba Pocket PC. 
For more information about using Windows Media Player for Toshiba Pocket PC, tap 

, and then tap Help. 

Tap to adjust volume. 

Indicates the progress of the  
current track. 

Tap to stop. 

Tap to skip to the next track. 

Tap to play a previous track. 

Tap to play or pause. 
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Microsoft Reader 
Use Microsoft Reader to read eBooks on your Toshiba Pocket PC. Download books 
to your computer from your favorite eBook Website. Then, use ActiveSync to copy the 
book files to your Toshiba Pocket PC. The books appear in the Reader Library.  
Each book consists of a cover page, an optional table of contents, and the pages of 
the book. You can: 
■ Page through the book by using the Up/Down control on your Toshiba Pocket PC 

or by tapping the page number on each page. 
■ Annotate the book with highlighting, bookmarks, notes, and drawings. 
■ Search for text and look up definitions for words. 
The Guidebook contains all the information you’ll need to use the software. To open 
the Guidebook, tap Help on the Reader command bar. Or, on a book page, tap and 
hold on the book title, and then tap Help on the pop-up menu. 
To switch to Microsoft Reader, tap , Programs, and then Microsoft Reader. 

Getting Books on Your Toshiba Pocket PC 
You can download book files from the Web. Just visit your favorite eBook retailer and 
follow the instructions to download the book files.  
Sample books and a dictionary are also included in the MSReader folder in the Extras 
folder on the Toshiba Pocket PC Companion CD.  
Use ActiveSync to download the files from your computer to your Toshiba Pocket PC 
as described in the Read Me file in the MSReader folder. 
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Using the Library 
The Library is your Reader home page; it displays a list of all books stored on your 
Toshiba Pocket PC or storage card. 
To open the Library: 
■ On the Reader command bar, tap Library.  
■ On a book page, tap the book title, and then tap Library on the pop-up menu. 
To open a book, tap its title in the Library list. 

 

Reading a Book 
Each book consists of a cover page, an optional table of contents, and the pages of 
the book. Navigation options are listed in the bottom portion of the cover page.  
The first time you open a book, you’ll probably want to go to the first page or to the 
table of contents, if there is one. Subsequently, whenever you open the book, you’ll be 
automatically taken to the last page read. 
In addition to the text, each book page includes a page number and book title. 

Tap to navigate  
to other parts  
of the reader. 

Tap to specify  
the books you  

want to display  
in the list. 

Tap to select  
a sort order. Tap to open  

a book. 

Tap to scroll  
through the  
Library list. 
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You can also page through a book by using the Up/Down control on your Toshiba 
Pocket PC. 

 

Using Reader Features 
Reading a book electronically gives you several options not available with paper 
books. These options are available from any book page. 
Select text by dragging across the text on the page. Then, tap an option on the pop-
up menu, as described here: 
■ Search for Text. Find text in a book by tapping Find on the pop-up menu. Enter 

the word you want to search for, and tap the desired Find option. Reader 
highlights found text on the page. To close Find, tap outside the box. To return to 
your original page, tap the title and then tap Return on the pop-up menu. 

■ Copy Text. You can copy text from books that support this feature into any 
program that accepts text. On a book page, select the text you want to copy. 
Then, tap Copy Text on the pop-up menu. The text can be pasted into the 
program of your choice. 

■ Bookmarks. When you add a bookmark to a book, a color-coded bookmark icon 
appears in the right margin. You can add multiple bookmarks to a book. Then, 
from anywhere in the book, tap the bookmark icon to go to the bookmarked page. 

■ Highlights. When you highlight text, it appears with a colored background.  
■ Notes. When you attach a note to text, you enter the text in a note pad that 

appears on top of the book page. A Note icon will display in the left margin. To 
show or hide the note, tap the icon. 

Drag to select text and then  
tap an option. 

Tap arrows to turn the page, or tap  
and hold page # to bring up  
page riffle. 

Tap to select a navigation option. 
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■ Drawings. When you add a drawing, a Drawing icon appears in the bottom-left 
corner of the page, and drawing tools appear across the bottom of the page. 
Draw by dragging your stylus. 

■ To see a list of a book’s annotations, including bookmarks, highlights, text notes, 
and drawings, tap Annotations Index on the book’s cover page. You can tap an 
entry in the list to go to the annotated page. 

Removing a Book 
When you finish reading a book, you can delete it to conserve space on your Toshiba 
Pocket PC. If a copy of the book is stored on your computer, you can download it 
again at any time.  
To remove a book from your Toshiba Pocket PC, tap and hold the title in the Library 
list, and then tap Delete on the pop-up menu. 
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Chapter 6 

Pocket Internet Explorer 

Use Microsoft® Pocket Internet Explorer to view Web or WAP (Wireless Application 
Protocol) pages in either of these ways: 
■ During synchronization with your computer, download your favorite links and 

mobile favorites that are stored in the Mobile Favorites subfolder in Internet 
Explorer on the computer. 

■ Connect to an Internet service provider (ISP) or network and browse the Web. To 
do this, you’ll need to create the connection first, as described in Chapter 7. 

When connected to an ISP or network, you can also download files and programs 
from the Internet or intranet. 
To switch to Pocket Internet Explorer, tap  and then Internet Explorer. 

The Mobile Favorites Folder 
Only items stored in the Mobile Favorites subfolder in the Favorites folder in Internet 
Explorer on your computer will be synchronized with your Toshiba Pocket PC. This 
folder was created automatically when you installed ActiveSync.  

Favorite Links 
During synchronization, the list of favorite links in the Mobile Favorites folder on your 
computer is synchronized with Pocket Internet Explorer on your Toshiba Pocket PC. 
Both computers are updated with changes made to either list each time you 
synchronize. Unless you mark the favorite link as a mobile favorite, only the link will 
be downloaded to your Toshiba Pocket PC, and you will need to connect to your ISP 
or network to view the content. For more information on synchronization, see 
ActiveSync Help on the computer. 

 

TOSHIBA Pocket PC e570 
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Mobile Favorites  
If you are using Microsoft Internet Explorer 5.0 or later on your computer, you can 
download mobile favorites to your Toshiba Pocket PC.  Synchronize the web content 
of your mobile favorites downloads your Toshiba Pocket PC so that you can view 
pages while you are disconnected from your ISP and computer. 
Use the Internet Explorer plug-in installed with ActiveSync to create mobile favorites 
quickly. 

To create a mobile favorite: 
1. In Internet Explorer on your computer, click Tools and then Create Mobile 

Favorite. 
2. To change the link name, enter a new name in the Name box.  
3. Optionally, in Update, select a desired update schedule. 
4. Click OK. Internet Explorer downloads the latest version of the page to your 

computer. 
5. If you want to download the pages that are linked to the mobile favorites you just 

created, right-click the mobile favorite and then click Properties. In the 
Download tab, specify the number of links deep you want to download. To 
conserve Toshiba Pocket PC memory, go only one level deep. 

6. Synchronize your Toshiba Pocket PC and computer. Mobile favorites that are 
stored in the Mobile Favorites folder in Internet Explorer are downloaded to your 
Toshiba Pocket PC. 

If you did not specify an update schedule in step 3, you will need to manually 
download content to keep the information updated on your computer and Toshiba 
Pocket PC. Before synchronizing with your Toshiba Pocket PC, in Internet Explorer on 
your computer, click Tools and then Synchronize. You will see the last time content 
was downloaded to the computer, and you can manually download content if needed. 
You can add a button to the Internet Explorer toolbar for creating mobile favorites. In 
Internet Explorer on your computer, click View, Toolbars, and then Customize. 

To save Toshiba Pocket PC memory 
Mobile favorites take up storage memory on your Toshiba Pocket PC. To minimize the 
amount of memory used: 
■ In the settings for the Favorites information type in ActiveSync options, turn off 

pictures and sounds, or stop some mobile favorites from being downloaded to the 
Toshiba Pocket PC. For more information, see ActiveSync Help. 

■ Limit the number of downloaded linked pages. In Internet Explorer on the 
computer, right-click the mobile favorite you want to change and then Properties. 
In the Download tab, specify 0 or 1 for the number of linked pages you want to 
download. 
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Using AvantGo Channels 
AvantGo is a free interactive service that gives you access to personalized content 
and thousands of popular Web sites. You subscribe to AvantGo channels directly from 
your Toshiba Pocket PC. Then, you synchronize your Toshiba Pocket PC and 
computer, or connect to the Internet to download the content. For more information, 
visit the AvantGo Web site. 

To sign up for AvantGo:  
1. In ActiveSync options on the computer, turn on synchronization for the AvantGo 

information type. 
2. In Pocket Internet Explorer on your Toshiba Pocket PC, tap the Favorites button 

to display your list of favorites. 
3. Tap the AvantGo Channels link. 
4. Tap the Activate button. 
5. Follow the directions on the screen. You will need to synchronize your Toshiba 

Pocket PC with your computer and then tap the My Channels button to complete 
the AvantGo setup. 

When synchronization is complete, tap the AvantGo Channels link in your list of 
favorites to see a few of the most popular channels. To add or remove channels, tap 
the Add or Remove link. 
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Using Pocket Internet Explorer 
You can use Pocket Internet Explorer to browse mobile favorites and channels that 
have been downloaded to your Toshiba Pocket PC without connecting to the Internet. 
You can also connect to the Internet through an ISP or a network connection and 
browse the Web. 

 

Back button. 
Refresh button. 
Home button. 
Favourites button. 
Hide pictures button. 
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To view mobile favorites and channels: 
1. Tap the Favorites button to display your list of favorites.  

 

2. Tap the page you want to view.  
You’ll see the page that was downloaded the last time you synchronized with your 
computer. If the page is not on your Toshiba Pocket PC, the favorite will be dimmed. 
You will need to synchronize with your computer again to download the page to your 
Toshiba Pocket PC, or connect to the Internet to view the page. 

To browse the Internet: 
1. Set up a connection to your ISP or corporate network using Connections, as 

described in Chapter 7. 
2. To connect and start browsing, do one of the following: 

■ Tap the Favorites button, and then tap the favorite you want to view. 
■ Tap View and then Address Bar. In the address bar that appears at the top 

of the screen, enter the Web address you want to visit and then tap Go. Tap 
the arrow to choose from previously entered addresses. 

To add a favorite link while using the Toshiba Pocket PC, go to the page you want to 
add, tap and hold on the page, and tap Add to Favorites. 

 

  

Tap to add or delete a folder or  
favourite link. 

Tap the favourite you want to view. 
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Chapter 7 

Getting Connected 

You can use your Toshiba Pocket PC to exchange information with other mobile 
devices as well as your computer, a network, or the Internet. You have the following 
connection options: 
■ Use the infrared (IR) port on your Toshiba Pocket PC to send and receive files 

between two devices. If this is the method you want to use, see the following 
section “Transfer Items Using Infrared.” 

■ Connect to your network. Once connected, you can send and receive e-mail 
messages by using Inbox and view Web or WAP pages by using Microsoft® 
Pocket Internet Explorer. The communication software for creating an ISP 
connection is already installed on your Toshiba Pocket PC. Your service provider 
will provide software needed to install other services, such as paging and fax 
services. If this is the method you want to use, see “Connect to the Internet” later 
in this chapter. 

■ Connect to the network at your company or organization where you work. Once 
connected, you can send and receive e-mail messages by using Inbox, view Web 
or WAP pages by using Pocket Internet Explorer, and synchronize with your 
computer. If this is the method you want to use, see “Connect to Work” later in 
this chapter. 

■ Connect to your computer to synchronize remotely. Once connected, you can 
synchronize information such as your Pocket Outlook information. If this is the 
method you want to use, see ActiveSync Help on your computer or Connections 
Help on the Toshiba Pocket PC. 
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Transfer Items Using Infrared 
Using infrared (IR), you can send and receive information, such as contacts and 
appointments, between two devices. 

To send information: 
1. Switch to the program where you created the item you want to send and locate 

the item in the list. 
2. Align the IR ports so that they are unobstructed and within a close range. 
3. Tap and hold the item, and tap Beam Item on the pop-up menu. 

You can also send items, but not folders, from File Explorer. Tap and hold the item you 
want to send, and then tap Beam File on the pop-up menu. 

To receive information: 
1. Align the IR ports so that they are unobstructed and within a close range. 
2. Have the owner of the other device send the information to you. Your Toshiba 

Pocket PC will automatically receive it. 

Connect to the Internet 
You can connect to your ISP, and use the connection to send and receive e-mail 
messages and view Web or WAP pages. 
You can connect to work in one of two ways: 
■ Create a modem connection. If this is the method you want to use, see “To create 

a modem connection to an ISP.” 
■ Use an Ethernet card and a net tap to connect to the network. If this is the 

method you want to use, see “To create an Ethernet connection to an ISP.” 

To create a modem connection to an ISP: 
1. Obtain the following information from your ISP: ISP dial-up access telephone 

number, user name, password, and TCP/IP settings. Some ISPs require 
information in front of the user name, such as MSN/username. 

2. Connect your Toshiba Pocket PC to an optional modem. You can use a connector 
cable to hook up to your wireless phone, with data capabilities. 

3. Tap  and then Settings. In the Connections tab, tap Connections. Under 
The Internet settings, select Internet Settings and tap Modify. 

4. In the Modem tab, tap New. 
5. Enter a name for the connection, such as “ISP Connection.” 
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6. In the Select a modem list, select your modem type. If your modem type does 
not appear, try re-inserting the modem card. If you are using an external modem 
that is connected to your Toshiba Pocket PC with a cable, select Hayes 
Compatible on COM1. 

7. You should not need to change any settings in Advanced. Most ISPs now use a 
dynamically-assigned address. If the ISP you are connecting to does not use a 
dynamically-assigned address, tap Advanced and then the TCP/IP tab, and 
enter the address. When finished, tap OK and then Next. 

8. Enter the access phone number, and tap Next. 
9. Select other desired options, and tap Finish. 
10. In the Dialing Locations tab, specify your current location and phone type (most 

phone lines are tone). These settings will apply to all connections you create. 
To start the connection, simply start using one of the following programs. Your Toshiba 
Pocket PC will automatically begin connecting. Once connected, you can: 
■ Send and receive e-mail messages by using Inbox. Before you can use Inbox, 

you need to provide the information it needs to communicate with the e-mail 
server. For specific instructions, see “Connecting Directly to an E-mail Server,” 
later in this chapter. 

■ Visit Web and WAP pages by using Pocket Internet Explorer. For more 
information, see Chapter 6. 

■ Send and receive instant messages with MSN Messenger. For more information, 
see “MSN Messenger”, in Chapter 5. 

To create an Ethernet connection to an ISP: 
1. You do not need to create a new connection on your Toshiba Pocket PC. Instead, 

you must purchase and configure an Ethernet card that is compatible with your 
Toshiba Pocket PC. 

2. Obtain the following information from your ISP: user name, password, and 
domain name. 

3. Insert the Ethernet card into your Toshiba Pocket PC. For instructions on inserting 
and using the Ethernet card, see the owner’s manual for the card. 

4. The first time you insert the card, Network Settings will appear automatically so 
that you can configure the ethernet card. Most networks use DHCQ, so you 
should not have to change these settings unless your network administrator 
instructs you to do so. Tap OK. (If it does not appear or to change settings later, 
tap  and then Settings. In the Connections tab, tap Network, tap the adapter 
you want to change, and then tap Properties.) 

5. Connect the Ethernet card to the network by using a network cable. For 
information, see your owner’s manual. 

6. Tap , Settings, Connections tab, and then Connections. From the My 
network card connects to list, select Internet. 
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To start the connection, simply start using one of the programs listed in the preceding 
section. Once connected, you can perform the same activities as listed in the 
preceding section. 

Connect to Work 
If you have access to a network at work, you can send e-mail messages, view intranet 
pages, synchronize your Toshiba Pocket PC, and possibly access the Internet. You 
can connect to work in one of two ways: 
■ Create a modem connection by using a RAS account. Before you can create this 

modem connection, your network administrator will need to set up a RAS account 
for you. If this is the method you want to use, see “To create a modem connection 
to a network.” Your network administrator may also give you VPN settings. 

■ Use an Ethernet card and a net tap to connect to the network. If this is the 
method you want to use, see “To create an Ethernet connection to a network.”  

To create a modem connection to a network: 
1. Get the following information from your network administrator: dial-up access 

telephone number, user name, password, domain name, and TCP/IP settings. 
2. Connect your Toshiba Pocket PC to an optional modem, like your data capable 

wireless phone. 
3. Tap  and then Settings. In the Connections tab, tap Connections. Under 

The Internet settings, select Internet Settings and tap Modify. 
4. In the Modem tab, tap New. 
5. Enter a name for the connection, such as “Company Connection.” 
6. In the Select a modem list, select your modem type. If your modem type does 

not appear, try reinserting the modem card. If you are using an external modem 
that is connected to your Toshiba Pocket PC with a cable, select Hayes 
Compatible on COM1. 

7. You should not need to change any settings in Advanced. Most servers now use 
a dynamically-assigned address. If the server you are connecting to does not use 
a dynamically-assigned address, tap Advanced and then the TCP/IP tab and 
enter the address. When finished, tap OK and then Next. 

8. Enter the access phone number, and tap Next. 
9. Select other desired options, and tap Finish. 
10. In the Dialing Locations tab, specify your current location and phone type (most 

phone lines are tone). These settings will apply to all connections you create. 
To start the connection, simply start using one of the following programs. Your Toshiba 
Pocket PC will automatically begin connecting. Once connected, you can: 
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■ Send and receive e-mail messages by using Inbox. Before you can use Inbox, 
you need to provide the information it needs to communicate with the e-mail 
server. For specific instructions, see “Connecting Directly to an E-mail Server,” 
later in this chapter. 

■ Visit Internet or intranet Web or WAP pages by using Pocket Internet Explorer. 
■ Send and receive instant messages with MSN Messenger. For more information, 

see “MSN Messenger”, in Chapter 5. 
■ Synchronize. For more information, see ActiveSync Help on the computer. 

To create an Ethernet connection to a network: 
1. You do not need to create a new connection on your Toshiba Pocket PC. Instead, 

you must purchase and configure an Ethernet card that is compatible with your 
Toshiba Pocket PC.  

2. Get the following information from your network administrator: user name, 
password, and domain name. 

3. Insert the Ethernet card into your Toshiba Pocket PC. For instructions on inserting and 
using the Ethernet card, see the owner’s manual for the card. 

4. The first time you insert the card, Network Settings will appear automatically so 
that you can configure the Ethernet card. Most networks use DHCP, so you 
should not have to change these settings unless your network administrator 
instructs you to do so. 

 Tap OK. (If it does not appear or to change settings later, tap  and then 
Settings. On the Connections tab, tap Network, tap the adapter you want to 
change and then tap properties.) 

5. Connect the Ethernet card to the network by using a network cable. For 
information, see your owner’s manual. 

6. Tap , Settings, Connections tab, and then Connections. From the My 
network card connects to list, select Work.  

7. If you want to synchronize your Toshiba Pocket PC, tap, and then ActiveSync. In 
the Tools menu, tap Options. In the PC tab, select Include PC when 
synchronizing remotely and connect to, and select your computer’s name. 
Remote synchronization with a computer will work only if you have set up a 
partnership with that computer through ActiveSync and have set ActiveSync to allow 
remote connections. Other restrictions apply. For more information on synchronizing 
remotely, see ActiveSync Help on the computer. 

To start the connection, simply start using one of the programs listed in the preceding 
section. Once connected, you can perform the same activities as listed in the 
preceding section. 

End a Connection  
To disconnect, do one of the following: 
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■ When connected via dial-up or VPN, tap the Connection icon on your navigation 
bar, and tap End. 

■ When connected via cable or cradle, detach your Toshiba Pocket PC from the 
cable or cradle. 

■ When connected via Infrared, move the Toshiba Pocket PC away from the PC. 
■ When connected via a network (Ethernet) card, remove the card from your 

Toshiba Pocket PC. 

Connect Directly to an E-mail Server 
You can set up a connection to an e-mail server so that you can send and receive e-
mail messages by using a modem or network connection and Inbox on your Toshiba 
Pocket PC. 

The ISP or network must use a POP3 or IMAP4 e-mail server and an SMTP gateway. 
You can use multiple e-mail services to receive your messages. For each e-mail 
service you intend to use, first set up and name the e-mail service. If you use the 
same service to connect to different mailboxes, set up and name each mailbox 
connection. 

To set up an e-mail service: 
■ In Inbox on your Toshiba Pocket PC, tap Services, and then New Service. 

Follow the directions in the New Service wizard. 
For an explanation of a screen, tap  and then Help. When finished, to connect to 
your e-mail server, tap Services and then Connect. For more information on using 
the Inbox program, see “Inbox: Sending and Receiving E-mail Messages” in Chapter 
4. 

Get Help on Connecting 
More information on the procedures described here, as well as information on 
additional procedures, can be found in the following locations: 
■ Inbox: Sending and Receiving E-mail Messages in Chapter 4. 
■ Online Help on the Toshiba Pocket PC. Tap  and then Help. Tap View, All 

Installed Help, and then Inbox or Connections. 
■ ActiveSync Help on the computer. In ActiveSync, click Microsoft ActiveSync 

Help on the Help menu. 
■ For troubleshooting information, see the Toshiba Pocket PC Web site at: 

http://www.microsoft.com/mobile/pocketpc. 
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Chapter 8 

Optional Functions 

Home 
You can launch the built-in or installed applications easily by tapping the icon 
displayed on the Home screen. You can also set to display a desired bitmap image on 
your screen background. 

Launching an Application From the Home 
1. Tap , Programs, and then Home to display the Home screen. 
 You can also launch the Home by pressing the Toshiba Pocket PC Home button. 
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For initial setting, the  
respective application  
icons are registered on  
three tabs: Main,  
Programs and Games.  
In the Running tab,  
active applications  
are displayed. 

Tap to select Large Icon, Small Icon  
or Text color… 

Tap to select Paste or Add. 

Tap to select Tab Settings…  
or About. 

Tabs. 
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2. Tap the desired tab, and then tap the application icon you want to launch. The 
selected application starts up. 

Also, you can launch an application by moving the cursor button to select and 
pressing the center of the cursor button to confirm. 
You can add tabs up to a maximum of 10 kinds and icons up to 18 in a tab. 

About Running 
In the Running tab, the active application names are displayed. 
The icons do not appear. 

Application Activate/Stop: 
Tap the application name you want to activate. You can also activate the application 
from the pop-up menu displayed by tapping and holding the application name. 

 

You can show a pop-up menu by tapping and holding any portion other than the 
application names displayed in the Running tab. In this case, only the Stop All is 
selectable. 

  

  

You can select the View menu or the  
Tools menu on the Running tab  
screen. You can select Text color… 
 from the View menu, the Tab  
Settings… or About from the  
Tools menu respectively. 

Tap to quit all running applications  
displayed in the Running tab. 

Tap to quit the selected application.  
When finished, the application name  
disappears. 

Tap to activate the selected application. 
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Display Icon List 
The following list shows the tabs and icons for the initial setup. 

Tabs Icons Applications 

Running — — 

Main  Pocket Internet Explorer 

  Windows Media Player 

  Notes 

  Tasks 

  Inbox 

  Calendar 

  Contacts 

  Pocket Word 

  Pocket Excel 

 
 

Calculator 

Programs 
 

File Explorer 

 
 

Backup 

 
 

Infrared Receive 

Games 
 

Solitaire 

Moving an Application Icon into Another Tab 
The moved icon is placed next to the last icon on the tab screen. 
You cannot move an icon into a tab which already contains 18 icons. 

To move using pop-up menu: 
1. Tap and hold the icon you want to move to display the pop-up menu. 
2. Tap Cut on the pop-up menu. 
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3. Tap the destination tab, and then tap Paste on Edit menu. The selected icon is 
pasted on the screen. 

You can also select Paste from the pop-up menu displayed by tapping and holding 
any portion other than the icon. 

To move using drag and drop: 
Tap the icon you want to move and drag it to the destination tab, and then drop it. 
The icon is transferred and that icon in the original tab screen is deleted. 

If the icon is dragged and dropped in the same tab, it will return to its original position 
on the tab screen. 

Deleting an Icon 
1. Tap and hold the icon you want to delete to display the pop-up menu. 
2. Tap Drop on the pop-up menu. The icon is deleted and the next icon positioned 

after the deleted icon automatically shifts to fill the deleted icon position. And all 
icons after the deleted icon likewise shift to fill the previous icon position. 

Adding an Icon 
You can add the application and your file icons to the Home screen. 
1. Tap Edit and then Add to display the Add Application screen. 
 You can also select Add from the pop-up menu displayed by tapping and holding 

any portion other than the icon. 
2. Tap ▼ of Application file to show the file list. If there is no desired file on the file 

list, you can find it by tapping Browse. To refer to all folders and files, tap Browse 
to show the Browse Dialog screen. When the file is selected, its name is 
displayed in the Application file box. 
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3. Enter an icon name in the Application name box, which is to be displayed on the 
Home screen. 

 You can enter up to a maximum of 32 characters. 
4. When finished, tap OK to close the Add Application screen, and the new icon is 

added to the Home screen. 

If the Application file is not designated, or if the Application name is not entered, you 
cannot add a new icon. 
You cannot launch the icon added from the storage card, if the same card is not 
inserted in the Toshiba Pocket PC. 

Tab Setting 
You can set to add, delete or rename the tab on the Tab Settings screen. You can also 
set to display a desired bitmap image on your screen background. 

To add a tab: 
1. Tap Tools and then Tab Settings to display the Tab Settings screen. 
2. Tap Tab Settings and then New to display a box to enter the new tab name. 
3. Enter a new tab name. When finished, tap OK to return to the Tab Settings 

screen. You can enter up to a maximum of 10 characters. 
4. Tap OK on the Tab Settings screen to return to the Home screen. 

  

Tap to move up to a directory folder  
one level above the currently  
displayed one. 

Tap to select kinds of application or  
file to be browsed. 

If a file is selected from the list, the  
screen returns to the Add  
Application screen. 

Tap to designate a folder you want to  
browse. When a storage card is  
inserted, files or folders contained in  
the storage card are displayed from  
the top directory. 
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To delete a tab: 
1. Tap Tools and then Tab Settings. 
2. Select the tab name to delete, and then tap Delete, the Delete tab dialog for 

confirming appears. Please note that all the icons contained in the same tab will 
also be deleted. 

3. Tap OK on the Delete tab dialog to delete the tab. When finished, the screen 
returns to Tab Settings screen. 

4. Tap OK on the Tab Settings screen to return to the Home screen. 

You cannot delete the Running tab. 

To change the name of a tab: 
1. Tap Tools and then Tab Settings to display the Tab Settings screen. 
2. Select the tab name you want to change, and then tap Rename. 
3. Enter a new tab name. When finished, tap OK to return to the Tab Settings 

screen. You can enter up to a maximum of 10 characters. 
4. Tap OK on the Tab Settings screen to return to the Home screen. 

You cannot rename the Running tab. 

To change a background: 
1. Select the background setup tab on the Tab Settings menu, and then tap Browse 

to display the Browse Dialog screen. 
2.  Even if a storage card is inserted, the files in the storage card will not be 

displayed. 
3. Tap the desired bitmap file from the list to return to the Tab Settings screen. 
4. Tap OK on the Tab Settings screen to return to the Home screen. 

If the selected file is not a bitmap file, you cannot set it on your screen background. 
The displayable range of the bitmap image on the Home screen is 240(W) x 246(H). 

Text Color Setting: 
You can set the color of application name for each tab using Text Color. 
1. Tap the tab whose color you want to set to display the selected tab screen. 
2. Tap View and then Text Color to display the color list. 
 You can set the color of the application name as desired. 
3. Tap the color you want to set, and the color of the application name changes. 
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How to Make a Backup 
You can make a backup of the Toshiba Pocket PC data in an SD memory card or a 
Compactflash (CF) card. If you have backed up your data on an SD or Compactflash 
card, you can restore that data in your Toshiba Pocket PC. You can also delete 
backup file data from the storage card. Periodical data backup is recommended. 
Data of the following three types can be backed up: 
■ File:  Includes a file created by Pocket Word, Pocket Excel, Notes, etc. or an 

additionally installed program and so on.  
■ Registry:  Setting information on Windows CE or Built-in Program. 
■ Database:  Database information of Microsoft Pocket Outlook. 
Data on password and so on from the setup menu cannot be restored. When 
attempting to make, restore or delete a backup, connect an AC adapter to the Toshiba 
Pocket PC before operation. 

If you update ROM programs using special installation programs with a *.xip 
extension, do not use the backup data which you made before updating ROM 
programs. 

Making a Backup 
1. Insert a storage card. 
2. Tap , Programs, and then Backup to display the Backup screen. 
3. Select Backup from Functionality, then select and tap Storage Card 1 or 

Storage Card 2 from Media. 

 

  

When an SD memory card and a  
CompactFlash card are inserted in the  
slots, check which one is  
Storage Card 1 or  
Storage Card 2 by looking at the  
storage capacity of the card. 

Select Backup from Functionality. 
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4. Tap OK to display the Backup password input screen. 
5. Input password. 

 

If you forget the password, you cannot restore the backup data. 
Do not forget your password. Write down the password and keep it in a safe place 
where only you know. 

6. When finished, tap OK. The Proceeding message is displayed during the backup 
process. 

 When the backup is completed, a backup finished message appears. 
7. Tap OK to return to the previous screen. 

If the remaining storage card capacity becomes short during backup, the backup 
process stops. Check the storage capacity before starting the backup. 
If the storage card is write protected, you cannot save the backup data. Cancel the 
write protection before starting the backup. 

  

  

Enter a password. 
You can enter a password up to a  
maximum of 16 characters. 
A backup can be made even without  
entry of a password. If a password is  
entered, that password is required  
at the time of restore. 
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 Carrying Out Restore Operation  
To restore is to overwrite the backed up data from the storage card onto the main 
memory of your Toshiba Pocket PC. 
■ If the same file name exists in the main memory of your Toshiba Pocket PC, the 

file data is replaced with the backup data from the storage card. 
■ If files exist in the main memory but not in the backup file, they will not be 

overwritten.  
1. Insert the storage card, which contains backup data into your Toshiba Pocket PC. 
2. Tap , Programs, and then Backup to display the Backup screen. 
3. Select Restore from Functionality, then select and tap Storage Card 1 or 

Storage Card 2 from Media. 

 

4. Tap OK to display the Restore password input screen. 
5. Enter a password, which was set up for this data backed up. 
 If you made a backup file without entry of a password, you don’t need to enter a 

password. 
6. When finished, tap OK. The restore message appears, and then the restore 

process starts. 
 When the restore process is completed, a restore finish message appears. 
7. Tap OK. Your Toshiba Pocket PC is reset and restarts automatically. 

When an SD memory card and a  
CompactFlash card are inserted in  
the slots, check which one is  
Storage Card 1 or Storage Card 2 
 by looking at the storage capacity  
of the card. 

Select Restore from Functionality. 
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If your Toshiba Pocket PC memory becomes short of its capacity during restore, the 
restore process stops. Increase the memory allocation of the main memory of your 
Toshiba Pocket PC (see Chapter 2. “Customize Your Toshiba Pocket PC”), and then 
restart the restore procedure.  

Deleting a Backup File. 
1. Insert the storage card, which contains backup data to delete. 
2. Tap , Programs, and then Backup to display the Backup screen. 
3. Select Delete Backup File from Functionality, then select and tap Storage 

Card 1 or Storage Card 2 from Media. 

 

4. Tap OK to display the Delete Backup File check screen. 
5. Tap OK to delete the backup file. 
 

  

When an SD memory card and a  
CompactFlash card are inserted in  
the slots, check which one is  
Storage Card 1 or Storage Card 2  
by looking at the storage capacity  
of the card. 

Select Delete Backup File from  
Functionality. 
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Chapter 9 

Additional Information 

Troubleshooting 
Check the following guide for the possible cause of a problem and how to correct it. 

Symptom Cause Correction 

Even if the power button is 
pressed and the power 
does not turn on. 

The built-in battery power 
is exhausted. 

Charge the battery. 

The power was suddenly 
cut off. 

The built-in battery power 
is exhausted. 

Charge the battery. 

 Automatic suspend is 
active. 

Select , Settings, 
System, Power to set to 
alter the power shut down 
time. 

Even if the built-in battery is 
completely charged, it 
discharges after a short 
period of time. 

The built-in battery is 
extinct. 

Replace the main battery 
with a new one. 

The screen was tapped, but 
the correct action was not 
executed. 

Touch screen adjustment 
is incorrect. 

Select , Settings, 
System, Screen, Align 
Screen to adjust the touch 
screen. 

 

TOSHIBA Pocket PC e570 

 User’s Guide 9-1 
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The operation is slow in 
response. 

Insufficient memory Secure the free memory. 
Quit the application if it is 
not in use. 

 Some malfunction Reset the system. If no 
action is observed after 
resetting the system, 
initialize the system. 
(However, the data will be 
deleted.) 

The screen was tapped, but 
there is no response. The 
operation button does not 
work either. 

Some malfunction Reset the system. If no 
action is observed after 
resetting the system, 
initialize the system. 
(However, the data will be 
deleted.) 

The screen is dark. The front light is off. Press and hold the power 
button until the front light is 
turned on. 

The screen is hard to see. Brightness setting is 
incorrect. 

Select , Settings, 
System, Front Light to 
adjust the screen brightness 
for better sight. 

Cannot connect to your 
computer. 

— See Help of ActiveSync. 

ActiveSync does not 
function when your Toshiba 
Pocket PC is connected to 
your computer with a USB 
cradle or USB cable. 

“USB SETUP TOOL” was 
not executed. It should be 
performed after execution 
of ActiveSync. 

Install “USB SETUP TOOL” 
contained in the Companion 
CD. 

 The USB driver of your 
computer may not be 
compatible. 

Reselect the USB driver. 

Cannot access the Internet. The connecting using a 
specified cellular phone 
connection cable was not 
correct. 

Check whether the 
connecting using a specified 
cellular phone connection 
cable is correct. 

 Radio waves of a 
connected cellular phone 
are getting worse. 

Carry out communications 
where radio wave conditions 
are satisfactory. 
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 Setting is incorrect. Carry out correct setting. 

Resetting 
Reset is equal to “Restart” of a computer. Carry out the reset in such unusual case as 
when a button or tapping the screen does not respond. When your Toshiba Pocket PC 
is reset, all data that was not stored during operation will be deleted. 

If the function cannot be restored even if the reset button is pressed, initialize your 
Toshiba Pocket PC. 

■ When the power is on, press the reset switch with the stylus, then release. 

 

Clear Memory 
When you initialize your Toshiba Pocket PC, it returns to the status when it was 
purchased.  

When you initialize your Toshiba Pocket PC, all data stored in the memory is deleted. 
Your Toshiba Pocket PC’s initially installed programs are not deleted. 
Before initialization, remove all storage cards. 

1. Turn off the power. 
2. Press the power button while pressing and holding the reset switch with the 

stylus, and then release the power button.  
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3. When a screen appears, release the reset switch. 
 When initialization is completed, the Welcome screen appears. Set up the system 

according to the screen as in the case of startup procedure. 

Specifications 

External dimensions 3.1”(W) x 0.7”(D) x 5”(H) (excluding protrusion part) 

Operating conditions Temperature: 32°F to 104°F, Humidity: 30 to 80% RH, 
when only the Toshiba Pocket PC is operating 

Temperature capable of charging: 41°F to 104°F 

Built-in battery  
Type Advanced Lithium Ion battery 
Continuing operating 
time 

Approx. 8 hours. 
For continuous indication of the Today screen, front 
light: OFF, ambient temperature: 25°C 

Memory keeping time Approx. 30 hours. 
If left at ambient temperature of 77°F after the power 
has become unable to turn on 

Note:  Continuing operating time and memory keeping
time vary according to the charging condition, ambient 
temperature, operating condition, etc. 

Processor Strong ARM SA-1110 

Action clock 206MHz 

Memory 64MB SDRAM 

Display Reflection color TFT, 240x320 pixels, up to 64,000 
colors 



 Additional Information  

User’s Guide  9-5  

Version   1   Last Saved on 10/18/2001 2:28 PM 

TOSHIBA Pocket PC e570  – Ppc_e570.doc – ENGLISH – Printed on 10/18/2001 as 01_GENUK 

Interfaces  
CF card slot CompactFlash card or CF+Card. Applicable only to 

Type I/Type II, 3.3V 
SD card slot SD memory card or SDI/O card 

Note:  The security function of the SD memory card is 
not usable. Data encrypted by the SD memory card 
security function-compatible equipment is not usable. 

Infrared port Based on IrDA Ver.1.2 
Maximum data transmission speed: 115 kbps 

Stereo headphone jack 0.14”, stereo mini plug compatible 
Remote control-fitted earphone (option) usable 

Cradle connection port  
AC adapter jack  

AC adapter Input power supply: 100–240VAC, 50/60Hz, 33VA 
Rated output: DC 5V, 3A  

Although the display is manufactured using an extremely high order of technology, 
there may be a case that some dots do not light or always light. It is not a malfunction. 
 
 


